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DEFINITIONS

doc TOC: The Table of Contents in the document.
em: This  is  a  font  size  measure  where  each  unit  is  represented  as  a  decimal 
fraction or multiple of the width of the letter 'm' from the current font. Hence the 
name: 'em'.
fixed  format  ebook: Refers  to  an  ebook  where  each  ebook  page  has  been 
converted into a photographic image(jpeg) of the page. A print replica ebook is 
similar; this is when each page in the published imprint book version is turned 
into  an  individual  photographic  jpeg image  for  the  ebook  version  so that  the 
ebook version looks exactly like the imprint or paperback version of your book.
Fx: Abbreviation for fixed format
jpg or jpeg: A bitmap file format used for storing images.
Interactive TOC: This is the TOC on the Kindle ereading device(aka NCX TOC or 
Logical TOC). It is not a reference to the TOC in the document.
KC: Abbreviation for Kindle Create.
kcb: The Kindle Create project file extension.
KDP: Abbreviation for Kindle Direct Publishing.
KFX: Kindle's  own  proprietary  version  of  fixed  format  ebook  and  reflowable 
ebook format that is used in Kindle Create.
KP: Abbreviation for Kindle Previewer.
KPF:  Kindle package format file extension.  This is  the file format that  is used 
when you create and save a Kindle Create doc for upload to KDP.
LITB: The Look Inside the Book version of a Kindle published ebook that is used 
for most ebooks found on Amazon.com.
LO: Abbreviation for LibreOffice.
Logical  TOC(aka  Nav  TOC):  The  Logical  TOC  is  the  TOC  that  is  created  and 
displayed only on the Kindle device itself(it is not a reference to the doc TOC in 
your ebook).
LW: Abbreviation for LibreOffice Writer
multi-level  or  multi-indented  TOC:  This  is  a  TOC  that  contains  both  main 
headings as well as indented subsection headings.



OO: Abbreviation for OpenOffice.
OW: Abbreviation for OpenOffice Writer
pixel or px: A measure which is normally used for setting the height/width size 
of images
pts: Abbreviation  for  the  'points'  measure  which  is  yet  another  measure  for 
setting font size.
reflowable ebook: An ebook that relies only on html text displays where the text 
"reflows" to accommodate all the different-sized device screens. This is also the 
reason  why  page  numbering  and  page  headers  are  not  allowed  in  reflowable 
ebooks.
single level TOC or Level 1 TOC: This is a TOC that is not multi-indented and 
which only displays the main headings based on "Heading 1" style only.
TOC: Abbreviation for Table of Contents.



INTRODUCTION

Kindle Create is rapidly becoming the primary go-to app for creating ebooks and 
paperback books on Amazon Kindle because, as you will discover, there are many 
apparent advantages in using this app for formatting and publishing both ebooks 
and  paperback  books  on  Amazon.  You  no  longer  have  to  purchase  expensive 
converter apps to convert your Word doc to ebook or paperback for upload to 
Amazon because Kindle Create is free. No html knowledge is needed because it's 
all just point and click. Using Kindle Create, you can edit the formatting, layout 
and book/ebook text and you can also add genre themes, dropcaps, blockquotes, 
separators and much more with just one or two clicks of your mouse. You can 
add, resize, replace and remove images quickly without any problems. Since their 
January 2019 software update, you can now also use Kindle Create to prepare and 
prepare and create a basic Kindle paperback book for Amazon upload where the 
manuscript upload involves no calculations whatsoever for trim, bleed, margins, 
spine etc. because they are all automatically calculated and added from the KDP 
Details and KDP Content metadata during upload and conversion. And the Kindle 
Create software updates and improvements are still coming thick and fast!      

The main purpose of this book is to give the reader a complete and convenient 
step-by-step companion guide – with all the necessary information in one place – 
on how to create ebooks for fiction and non-fiction novels as well as describing 
how to format and create paperback books using Kindle Create. This book will, 
descriptively and visually, show new Kindle Create users all the necessary and 
basic steps required to create text-heavy, reflowable ebooks(e.g. fiction or non-
fiction novels) by loading a Word doc into Kindle Create and will also show the 
user  how  to  produce  image-dense,  fixed  format  ebooks(e.g.  travel  books  or 
cookbooks or books of poems) using a PDF document in Kindle Create. The user 
will be shown how to format and create a paperback book using Word and Kindle 
Create.  This guide also includes useful tips, tricks and advice on how to avoid and 
resolve formatting/layout problems and also includes advice on how to speed up 
your  Kindle  Create  workflow  to  achieve  a  quality  ebook  or  paperback  book. 
However, take note this book will not describe how to format or publish Comic 
books using Kindle Create.

Also please  note that  this  book  will  only  describe how  to prepare ebooks  and 
books  using the  standalone  application  version  of  Kindle  Create  for  Windows 
only and will not describe how to use the Kindle Create add-in for Word. This 
book will also not cover how to publish using Kindle Create on an Apple Mac.



If  you  are  an  indie  author  and  publisher  with  a  consistent  track  record  of 
preparing and uploading Word docs for direct upload to KDP, who is considering 
switching  to  using  Kindle  Create,  this  move  should  be  a  relatively  easy  and 
simple process for you because you should already know all about how to prepare 
Word docs according to the Kindle formatting rules for Word, which is also an 
essential prerequisite before you load your Word doc into Kindle Create.  So all 
you have to really learn is how to use the Kindle Create app, which is what this 
book is all about.

I should also be clear that there is no chapter or section within this book that is 
solely dedicated to fully describing and showing the layout and usage of all the 
widgets and bits and bobs within the Kindle Create application itself. In my own 
mind, simply describing the layout and usage in words and images in any how-to 
book is really not the way anyone is going to quickly and instinctively learn how 
to use any new software application. 

I learned how to use Kindle Create by loading a Word doc or PDF file into KC and 
playing  with  it  every  day  until  the  app  layout  and  usage  became  completely 
instinctive and second nature to me. But I've also read about some first time indie 
authors  who,  believing  that  Kindle  Create  was  a  breeze  to  use  and  after 
formatting in their  book or ebook in Word or LibreOffice Writer,  loaded their 
Word  doc  into  Kindle  Create  for  the  first  time  ever  with  the  expectation  of 
successfully finishing-off their ebook and publishing in record time without any 
problems at all.  This is really the worst way to do it! In my opinion, any indie 
author or indie publisher who takes that route and who is unwilling to take time 
out to thoroughly learn how to use an essential tool of their trade – and learn it 
well – deserves all the formatting hell and angst that they get. The only way to 
learn the layout and usage of Kindle Create – or any new software application for 
that matter – is to play with it and practice, practice, practice until you become an 
expert user.



PART I

About Kindle Create



CHAPTER 1

All About Kindle Create

I remember using Kindle Create(KC) for the first time when it was first released in 
early  2017.  I  was  quite  intrigued  and  excited  because  it  was  the  first  ever 
application  released  by  Kindle  that  allowed  the  app  user  to  fully  format  a 
reflowable ebook or fixed format ebook for upload to KDP. And it was a free app! 
More as a consequence of my own curiosity than anything else, I started using 
and playing with the new KC application every day.  I  also remember that the 
documentation for Kindle Create at the time was rather sketchy and poor and 
there were no how-to videos describing how to use Kindle Create properly at that 
time.  But,  ever  curious,  I  still  continued  playing  with  the  Kindle  Create 
application.

I've been involved with ebook and book publishing for about the last 11 years. 
During  this  time  I've  used  several  major  application's  to  produce  my 
ebooks/books including Word, Calibre, InDesign, Jutoh, Scrivener and Sigil(free 
epub editor) at various times and I've become reasonably expert at using all of 
them. This may seem an odd thing to admit(and expensive!) but my purpose in 
using all these apps was always to find the simplest and easiest-to-use ebook or 
book formatting application, with the shortest learning curve, that would give 
me the best quality ebook in the shortest amount of time possible. And to do that 
you have to compare ebook conversion apps.

So how does Kindle Create stack up against its rivals both as a converter and as an 
ebook/book finishing-off tool?

I've been a member of the KDP Community Forum for many years. Inexperienced 
Indie authors use this forum to ask questions in order to get more experienced 
forum members to help advise them on how to sort out their Kindle formatting 
problems and issues. And there are many on this forum today that still believe 
and insist that Kindle Create is "a bad application" whose use should always be 
avoided.  Usually  the  forum  members  who  give  such  negative  advice  have  no 
significant experience whatsoever in how to use the Kindle Create app and yet 
they still condemn it. I also think that these forum members have judged the KC 
app only according to how many problems are appearing on the KDP Forum. I call 
this a knee-jerk judgment, which is not fairly based on personal app usage or app 



experience. After all, it wasn't so long ago that there were a large number of KDP 
forum  posts  ever  day  from  Indie  authors  who  were  having  great  trouble 
preparing  and  uploading  a  Word  doc  direct  to  KDP.  Now  Word  doc  ebook 
formatting and upload problems are just a mere trickle on the KDP Forum. And I 
believe,  in  time,  that  the  same  thing  will  happen  with  Kindle  Create.  I  also 
personally believe,  through continuously  using the KC app for over two years 
now, that Kindle Create is a worthy and useful free app because, with the Kindle 
Create app, Amazon Kindle has managed to greatly simplify the ebook and print 
book  process  for  indie  publishers  while,  at  the  same  time,  also  significantly 
raising the bar for the production of individualized, quality book interiors.  

So why do indie publishers have so much trouble with using Kindle Create?

I've  often  thought  about  that  question  and  I  think  that  there  are  three  main 
reasons for new users having such difficulties. The first reason for this is that I 
still  remain  unimpressed  with  Kindle's  how-to  documentation  and  how-to 
videos on KC which are both still  rather thin on detail,  sketchy and relatively 
poor.  Poor  documentation  and  lack  of  clarity  and  detail  in  the  how-to 
documentation will always cause problems for any new user. It also doesn't help 
the user if the Kindle Create information is at many disparate internet locations – 
all over the place on the web. Indeed, this is the main reason I'm writing this book 
–  to  clearly  define  and  explain  every  aspect  of  how  the  user  can  successfully 
format and publish his ebook or paperback book using Kindle Create for upload to 
KDP where all the required information is in one place – in this book.

The second reason for user difficulties with the KC app is probably because of 
Kindle  Create's  application  behavior.  The  KC  application  window  layout  and 
behavior, in terms of usage, does not really resemble or conform to any normal 
"standard application" layout or behavior on a Windows computer. I think this 
non-standard  application  layout  and behavior  is  what  sometimes  confuses  or 
rattles some people when they first start using KC. The solution to this problem is 
just to do what I did. Just have the patience to keep playing and practicing with 
the Kindle Create application every day and you will soon become an expert.

The third reason – particularly when you load a Word doc into KC – is probably 
the  most prevalent and cogent reason  that  people have problems with  Kindle 
Create.  From all  the  posts  on  the  KDP Forum  concerning KC app  problems,  it 
became apparent to me that many KC users seemed to be taking shortcuts  in 
Word  or  LibreOffice  Writer  –  they  were  not  accurately  following  the  Kindle 
Formatting Guidelines for Word or they just didn't know how to use MS Word or 
LW properly. It really is a primary and an essential prerequisite that you should 
be able to use MS Word or LibreOffice Writer properly and know and apply all the 



Kindle formatting rules for Word if you also expect to format your ebook easily, 
quickly and efficiently in Kindle Create without any problems. 

In my own experience with using KC, I've found that if you format your Word 
doc layout and text as perfectly and completely as you can using paragraph styles 
before you load your Word doc into KC, then this will actually help to greatly 
reduce the number of editing and layout tasks that you will have to do in Kindle 
Create(already been done in Word) and there will also be less conversion issues or 
errors  to  sort  out  as  well.  Remember  that  Kindle  Create  should  be  used  as  a 
finishing-off tool  for your ebooks and paperback books so if  you always do as 
much formatting, styling, editing and layout as you can in Word before you load 
your Word doc into KC then you will truly reap the benefits.               

Limitations of this Book
This  book  will  only  show  the  user  how  to  use  the  Kindle  Create  standalone 
application on a Windows PC or Windows laptop so there will be no descriptions 
on how to use Kindle Create on a Mac.

There will also be no descriptions of how to use the Kindle Create Word add-in 
because the add-in app layout and usage is virtually the same as the standalone 
app  usage  and  so  repetition  is  unnecessary.  The  other  reason  I  will  not  be 
showing how to use the Kindle Create add-in for Word is because it is still in Beta 
testing.  This  means  that  there  are  still  some  outstanding  problems  or  major 
issues with the add-in version of Kindle Create.  And this is also why I always 
advise that users should, for now, preferably always use the standalone version 
of the Kindle Create application which is currently on general release with few 
major or outstanding software issues.

This book will not show the user how to create a Comic Book using Kindle Create. 
This book will only describe how to create reflowable ebooks, fixed format ebooks 
and paperback books using Kindle Create. 

This book will also not describe, in any great detail, how the user must format 
their Word doc before loading it into KC because this is a how-to book on Kindle 
Create and not a how-to book on MS Word or LibreOffice Writer.  But I will  be 
giving a step-by-step overview of what the user must know and do to properly 
prepare a Word doc in Chapter 2 and in Chapter 3 using MS Word or LibreOffice 
Writer respectively -- before loading it into KC. 

I will also be using Kindle Create v1.29 for Windows  as my reference,  which is 
the most current version at the time of writing this book.



Useful References
The  following  links  should  provide  further  useful  information  on  how  to 
properly format your Word doc and Kindle Create usage.

Kindle Jumpstart Website
Amazon Kindle Publishing Guidelines(for Word)
eBook Manuscript Formatting Guide(for Word)
Prepare Reflowable eBooks with Kindle Create
Building Your Fixed Format eBook with Kindle Create
Kindle Tools and Resources

You should also download and install Kindle Previewer from Amazon for Kindle 
ebook testing. You can also download and install Adobe Acrobat Reader(free) for 
checking your PDF files(used for fixed format ebooks only). You will also need a 
graphics  app  like  Adobe  Photoshop(paid),  GIMP(free)  or  Irfanview(free)  to 
create your cover and to format or resize the images for your book or ebook. 

Requirements and Preparation
In order to begin learning how to properly use Kindle Create,  you should first 
download and install the Kindle Create standalone application from the Amazon 
Kindle  Jumpstart website.  The  Kindle  Jumpstart website  also  has  videos  and 
descriptions  that  will  give  you just  a  cursory  rundown  on  how  to  use  Kindle 
Create,  which  you  should  also  view  and  thoroughly  read  if  you  can. 
Unfortunately,  I've also found that the current crop of KC documentation and 
videos  are,  at  best,  unclear  and  somewhat  lacking  in  complete  and  accurate 
information, which can be misleading and confusing for the new KC user. The 
how-to descriptions also never seem to keep pace with the more recent Kindle 
Create updates or newly added KC functionality.

If you are intent on creating a reflowable ebook, fixed format ebook or paperback 
book using Kindle Create then you should also make absolutely sure that you are 
adequately prepared and proficient in using MS Word or LibreOffice Writer on 
Windows – you should already know the layout of MS Word or LibreOffice Writer 
well and you should also know how to apply and use paragraph/heading styles in 
both these apps. If you are not up to speed on how to use these apps properly, 
according  to  the  Kindle  Jumpstart guides  or  according  to  the  Amazon  Kindle  
Publishing Guidelines for Word, then you are likely to have major problems when 
you eventually test or upload your Word doc to Amazon Kindle via Kindle Create. 
And since  it  is  not  the  job  of  this  book  to teach  you how to  use  MS Word  or 
LibreOffice Writer, I shall be giving only a cursory overview or basic outline on 

https://kdp.amazon.com/en_US/help/topic/G200735480
https://kdp.amazon.com/en_US/help/topic/G201723070
https://kdp.amazon.com/en_US/help/topic/G200645680
https://kdp.amazon.com/en_US/help/topic/G7R2L7V5X6SJH948#toc
https://kdp.amazon.com/en_US/help/topic/GMUKXSTBCN6F2TGM
https://kdp.amazon.com/en_US/help/topic/G202131170
https://www.amazon.com/Kindle-Create/b?ie=UTF8&node=18292298011
https://kindlegen.s3.amazonaws.com/AmazonKindlePublishingGuidelines.pdf


how to prepare and format your book or ebook using MS Word or LibreOffice 
Writer before loading your Word doc into the Kindle Create app.

And it doesn't matter whether you are preparing a Word doc for direct upload to 
KDP or whether you are preparing a Word doc to load into Kindle Create – in both 
instances you must always apply exactly the same Kindle formatting guidelines 
or rules for Word and prepare your Word doc in the same way. If you don't bother 
to learn and apply the  Kindle formatting guidelines for Word properly then I 
guarantee that you will have constant problems.

Lastly,  in  this  book  there  will  be  no detailed  descriptions  of  layout  or  widget 
usage of the Kindle Create app. That's because you cannot learn the ins and outs 
of how to use an app like Kindle Create – or any other complex app – from a book. 
And since  Kindle  Create  should  be  regarded as  an essential  tool  for  any  indie 
publisher  intent on using it,  it  is  therefore  up to  you to  learn the  layout  and 
behavior of Kindle Create. So I would therefore strongly advise that you spend at 
least an hour or more every day dedicated to just learning the layout and usage of 
all the widgets in Kindle Create so that it becomes instinctive and easy to use. 
And you should learn how to use Kindle Create well before you decide to publish 
your ebook/book to avoid problems. The last thing you should do is write and 
format your book in MS Word or LibreOffice Writer and then throw your Word 
doc into Kindle Create for the first time ever with the crazy expectation that it 
will  be  a  breeze  and  you  will  have  no problems  at  all  –  you  certainly  will  be 
inviting trouble and catastrophe if you do it that way.                  

Enabling Access to All Kindle Create Functionality
Kindle Create has been constantly improved with major updates ever since its 
debut  in  January  2017.  Many  of  KC's  new  features  are  still  in  Beta  Test. 
Nevertheless, you will need to access and use all the new or updated functionality 
in the Kindle Create app to create books and ebooks, so you should always ensure 
that  Early  Access is  enabled  in  Kindle  Create.  So,  within  the  Kindle  Create 
application, click on Help > Settings > Language to set the application language 



in the  Kindle Create Options window. Then click on  Help > Settings > Early 
Access and tick "Enable Beta Features" and click on the "Save" button to enable 
access to all the new or updated features in Kindle Create.  

What is KFX Format?
KFX is a relatively new and improved Kindle format that was introduced in 2015. 
Kindle Create produces a KPF file for upload to Amazon Kindle, which will then 
always  be converted to KFX format for download  delivery to the more recent 
versions of KFX-enabled Kindle devices like Kindle Fire, Kindle HD and Kindle 
Touch. Kindle Create always produces ebooks and comic books in KFX format, 
which has the following new features:

Page Flip: Page Flip is a new Kindle navigation feature that gives the customer a 
bird’s eye view of your book while always saving their place. 

High definition visuals (HDV) support: High definition visual support improves 
on image zooming, pinching, and panning by using new display technologies and 
device capabilities.

Progressive download: Progressive download allows a customer to start reading 
their book while it is still downloading. 



Font  size  layout  improvement: Enhanced  Typesetting  automatically  adjusts 
when the font size is large or the line length is short, to improve readability by 
preventing large gaps between words or squashed text. 

Drop  caps: Drop  caps  automatically  adapt  their  line  height  to  the  customer's 
screen size and font settings.

Ragged right justification:  This feature allows customers to change the current 
default setting (full justified) to left aligned (ragged right) instead.

Hyphenation  and  smoother  word  spacing: Advanced  hyphenation  and 
justification reduces distracting gaps of white space in the text.

Kerning  and  ligatures: Kerning  makes  word  shape  recognition  easier  by 
removing subconsciously distracting spaces between specific letter pairs.

Dynamic color contrast: With Enhanced Typesetting, text of any color will be 
legible  above  any  background  color.  Font  colors  will  adapt  automatically  to 
provide  sufficient  contrast  with  either  the  device  color  theme  chosen  by  the 
reader or to the background color of any page-level element.

Enhanced table formatting: With Enhanced Typesetting, readers can see the full 
text of tables adjusted for smart layout on different device sizes. Larger tables 
open with full size text in an upgraded table viewer with pan and zoom. Text in 
tables is selectable for highlights or notes.

MathML: Enhanced  Typesetting  supports  MathML,  which  can  be  used  for 
mathematical notation and mathematical content.
(Source: https://kdp.amazon.com/en_US/help/topic/G202087570)

Concerning the  HDV image support for KFX, in order to achieve this you must 
also comply with their image size specifications, which are described below:

1. For 50% screen width, your image must be at least 600 x 900 px in size.

2. For 75% screen width, your image must be at least 900 x 1350 px in size.

3. For 100% screen width, your image must be at least 1200 x 1800 px in size.

The  most  important  dimension  in  the  above  specification  for  creating  your 
HDVebook images is the width dimension. And if you are creating images then 
you  should  use  the  width  dimension  as  your  guide  and  use  the  resize  image 
capability in Kindle Create to appropriately resize your image to 50%, 75% or 
100%  of  ereader  screen  width.  You  should  also  be  aware  that  the  required 
HDVimage dimensions are indeed quite large and could be expensive because 

https://kdp.amazon.com/en_US/help/topic/G202087570


you might well incur a sizeable download file size profit penalty from Amazon 
Kindle – especially if you are creating an image-dense ebook. So use this feature 
wisely and always make sure to use a good image compression application like 
the  TinyPNG website on your images before inserting images into your ebook. 
See this link for further details. 

Why Use Kindle Create?
Most experienced indie authors who have directly uploaded Word docs to KDP as 
ebooks  know  what  they  will  get  as  a  Kindle  ebook.  They  will  get  an  Amazon 
Kindle  reflowable  ebook  which  is  single  font  throughout  with  hardly  any 
noticeable or pleasing interior styling at all. There are even some indie authors 
out there who believe that interior styling in an ebook is entirely unnecessary 
and is a waste of time and effort – it's irrelevant! – because it's only the story and 
words that matter in any ebook. That's fair enough. But I also know that there are 
plenty of other people out there, like me, who want to produce an ebook with 
professional  styling  and  with  a  more  pleasing  interior  –  with  styling  that  is 
nearly  equivalent  to  producing  an  ebook  in  epub  format,  which  is  how 
professional formatters always create their ebooks. So if you have the same view 
as me, then you should consider using Kindle Create for both your ebooks and 
books for Amazon Kindle. And did I also mention that if you format your ebook in 
Kindle Create no html knowledge is needed? – It's all just point and click. 

And if you use Kindle Create to create your paperback book you will discover that 
it  is  by  far  the  fastest  and  easiest  way  to  produce  a  paperback  for  upload  to 
Amazon Kindle. And did I mention that there are no trim, margin, bleed, spine or 
gutter calculations to work out because these calculations are all automatically 
set  or  calculated  when  you  upload  your  book?  To  be  fair,  there  are  some 
downsides  to  publishing  a  book  or  ebook  using  KC  and  these  are  all  fully 
described and explained in the following sections. 

Pros and Cons of Creating a Reflowable eBook
What follows are the pros and cons of loading a properly formatted Word doc 



into Kindle Create to create a reflowable ebook:

The Pros:
1. Useful  and  fairly  easy  for  creating  and  uploading  text-heavy  reflowable 

ebooks including fiction and non-fiction.

2. Enhanced Typsetting will always be assured in your Kindle ebook.

3. You can edit and correct proof mistakes in the KC Editor just like you can in 
Word.

4. You can improve the interior styling of your ebook by adding theme fonts that 
are  appropriate  to  your  ebook's  genre.  Currently,  there  are  four  themes 
available to the user: Modern, Classic, Cosmos and Amour.

5. You can easily create an  Interactive TOC(aka  Logical TOC  or NCX TOC) for 
your ebook. The Interactive TOC is the TOC that is created and displayed on 
the Kindle device itself(it is not a reference to the doc TOC in your ebook).

6. You can now also create a single level doc TOC(without multi-indenting) in 
KC.

7. You can easily edit and change the styling of all headings, reading text and 
spacing in your ebook.

8. You can also create page-breaks and merge chapter sections in KC.

9. You  can  add  stylish  dropcaps,  separators,  blockquotes,  citations,  opening 
quotes etc. easily with a few clicks.

10.You can change fonts in your ebook. The fonts currently available, depending 
on  the  themes  you  use,  are  Bookerly(serif),  Amazon  Ember(sans  serif), 
Monospace(monospace), Great Vibes and Exo.

11.You can  now also insert,  remove,  replace  and  resize  your ebook  images  in 
Kindle Create without problems.

12.All  internal  and external  links created in Word will  be preserved in Kindle 
Create.

13.You can now add, edit or remove internet links in Kindle Create.

14.You  can  and  should  regularly  save  your  KC  ebook  as  a  project  directory 
containing the KCB file, which will allow you to make any necessary editing 
changes in the future to your published ebook. The KCB file is the project file 
containing your ebook that you can load directly into Kindle Create.

The Cons:



1. Doesn't allow the user to set and use named paragraph styles as in Word. KC 
only uses inline styling so you will have no choice but to format all images, 
headings, text, paragraphs, and spacing on a repetitive one-by-one basis in the 
Kindle Create app.

2. You will  only be able to  test  your new  KPF file in  KC Preview and  Kindle 
Previewer(free  download  from  Amazon.com)  and  using  the  Kindle  eBook 
Preview when you upload to KDP. You will not be able to side-load your KPF 
file onto a Kindle device for further testing.

3. You can only upload a KPF file to Kindle but you cannot upload KPF format to 
any other epub retailer like iBookStore, Nook or Kobo. 

4. You cannot add or edit endnotes, tables or lists in KC

Pros and Cons of Creating a Fixed Format eBook
Here are the pros and cons of loading a PDF into Kindle Create to create a fixed 
format ebook:

The Pros:
1. This is by far the easiest way to create an ebook. But not so fast!...Before you 

clap  your  hands  with  joy,  dance  the  Macarena  and  shout  'Hallelujah'  you 
should take a deep breath and read The Cons section carefully. 

2. You can easily create an Interactive TOC for your ebook. The Interactive TOC 
is the TOC that is created and displayed only on the Kindle device itself.

3. You can remove and insert pages in PDF format.

4. You also choose to preserve all links, which includes the links in your doc TOC.

5. You can add and store media files in your ebook.

The Cons:
1. You will not be able to do any editing or layout tasks in KC.

2. Once uploaded to Amazon Kindle, your fixed format ebook can only be viewed 
and read on larger screen Kindle tablets and computers but cannot be read on 
smaller devices like mobile phones.

3. The Kindle device user will not be able to change fonts or change font size and 
zoom will not work well.

4. The link to 'Table of Contents' will not work in the Go To or Navigation menu 
items on all Kindle reading devices. It will always be grayed out.



5. Your ebook will not be searchable on any Kindle ereading device.

6. You will probably lose most, if not all, your ebook profits, depending on the 
actual file size of your uploaded KC fixed format ebook. Unfortunately, if you 
have, say, a hundred pages in your PDF file then this will convert to a hundred  
page-size jpeg images in your KC doc. This means that that the upload size of 
your KPF file in megabytes will be huge. Kindle has a download limit file size of 
only 5 Mb per ebook. Kindle also has a download penalty of $0.15 per Mb over 
that download limit. Since your hundred page fixed format ebook is likely to 
be hugely over that download limit, this means that, if you choose the normal 
70% profit option before upload, your profits per book sold will most likely 
end up being zero. So the best you can hope for here is to select the 35% profit 
option which will give you only a small profit per book at best.

7. Currently you should be aware that in all fixed format ebooks created using 
Kindle Create, all internal links and internet links will not work across most 
Kindle devices. This is a known bug in Kindle Create which Kindle developers 
are currently trying to resolve.

Reflowable eBook or Fixed Format eBook?
Using Kindle Create, it should be pretty obvious from above that there are many 
more disadvantages if you create a fixed format ebook(using a PDF) than if you 
create a reflowable ebook(using a Word doc). It's also somewhat ironic that the 
only apparent advantage in creating a fixed format ebook in Kindle Create is that 
it's very easy.

So the general consensus is to preferably always create a reflowable ebook in KC 
using a Word doc if you can. In my opinion, there are just too many significant 
disadvantages and monetary penalties if you create a fixed format ebook using a 
PDF in KC. You should only ever load a PDF into KC to create a fixed format ebook 
as  a  last  resort  in  order  to  create  an  image-dense  ebook(e.g.  for  cookbooks, 
textbooks, travel books or a book of poems).

Pros and Cons of Creating a Paperback Book
What follows are the pros and cons of loading a properly formatted Word doc in 
Kindle Create to create a paperback book:

The Pros:
1. Much easier and quicker than using the regular method of uploading a Word 

doc or PDF file directly to KDP Paperback

2. Creating a paperback book in Kindle Create has exactly the same advantages 
and disadvantages as creating a reflowable ebook in KC because both these 



routes use a Word doc loaded into Kindle Create. 

3. All trim, spine, bleed, margins, paper color etc data are automatically set or 
calculated  from  the  metadata  on  your  KDP  Book  Details page  and  KDP 
Paperback  Content page  when  you  upload  and  convert  your  book.  So  you 
won't have to do any complicated calculations to create your paperback book.

4. Author/title headers and page numbers layout can now be styled in different 
ways by selecting the Print Settings button in the Kindle Create toolbar.

5. The  alternating  author/title(headers)  and  page  numbering(footers)  will 
automatically  be  calculated  and  appropriately  inserted  during  upload  and 
conversion to KDP Paperback.

6. Appropriate page numbers are automatically added to the book's TOC items 
on the KC-generated TOC page when you upload to KDP Paperback. 

7. If you are publishing a novel both as an ebook and a paperback then you can 
use the reflowable ebook's already formatted KCB project file in Kindle Create 
as the start point to create your paperback, which will  make the paperback 
creation process even easier and faster in KC. And what you will get, in terms 
of styling and layout,  is a paperback book that will look exactly the same as 
your ebook. 

8. You  can  check  your  whole  book  in  Kindle  Book  Preview on  the  KDP 
Paperback Content page when you upload your book using KDP Paperback.

The Cons:
1. You  can  only  create  one  section  with  consecutive  page  numbering.  For 

instance, you will not be able to create another separately numbered section 
for the front matter.

2. You cannot use a doc TOC that has been created in Word in Kindle Create for 
paperback books.

3. The doc TOC that you must create in Kindle Create can only be a single level 
TOC(not multi-indented). A TOC created in Word cannot be used.

4. Only a limited number of fonts are available for use in your paperback book.

KPF Upload or Direct PDF Upload for Paperback?
To be honest about this comparison, there are particular advantages for each of 
these methods for creating a paperback for upload to Amazon Kindle, so it's really 
up to you.



If you are particular or pedantic about the formatting of your paperback book 
and prefer to use other fonts like Garamond or Palatino for your book or if you 
prefer styling your headers and page numbering footers yourself or if you prefer 
to  also  have  separate  page  numbering  in  your  front  matter  then  you  should 
perhaps  create  your  book  using  the  more  direct  Word  or  PDF  upload  to  KDP 
Paperback method.  

But if you want a much faster and simpler method of creating your paperback 
book where, if you do it right, your ebook styling will look exactly the same as 
your paperback styling then uploading a KC-generated KPF file to KDP Paperback 
will probably be your preference.   



PART II

Preparing your Word doc for Kindle Create



CHAPTER 2

Preparing a Word Doc Using MS Word

In order to create a Kindle Create KPF file in the most efficient way to minimize 
the amount of formatting that needs to actually be done in Kindle Create, it's a 
good  idea  to  first  fully  format  your  ebook  as  a  Word  doc  whose  layout  and 
formatting will be to your own particular preference. This means that, in terms 
of both formatting and layout, you should create your ebook in MS Word exactly 
as you wish to see it as an ebook. If you fully format your Word doc as I suggest – 
without skimping or taking shortcuts – then this will help to greatly to minimize 
any  formatting  and  layout  tasks  that  will  be  required  when  you  eventually 
finish-off your ebook in Kindle Create. This formatting tactic will also help save 
you a lot of time and what follows is,  essentially,  the way I would personally 
format and prepare a Word doc(with options) for Kindle Create.

Kindle Create users should also be aware that it doesn’t matter whether you are 
preparing  a  reflowable  ebook,  a  fixed  format  ebook  or  a  paperback  book,  the 
initial Word doc preparation, in terms of formatting, styling and layout will be 
exactly the same for Kindle Create. 

What  follows  in  this  section is a  step  by  step  overview  which  will  show  the 
reader  how  to  properly  prepare  their  Word  doc  for  Kindle  Create.  I  have  also 
assumed that the reader already knows how to use the MS Word application. I 
will be describing how to format a Word doc using Word 2007.

Here  is  a  brief  overview  of  the  formatting  and  layout  tasks  you  will  have  to 
complete in Word:



1. Format the book title and subtitle elements on the title page.

2. Format the ebook's body text or reading text.

3. Format all major headings and chapter headings using a single heading style. 

4. Create a multi-level(multi-indented) TOC or a single level doc TOC.

5. Add ebook images(optional).

6. Add internal and external links. 

7. Add special Kindle formatting requirements.

Detailed Workflow
What  follows  is  an  overview  of  how  you  should  prepare  your  Word  doc  for 
Kindle Create:

1. Format your book title
Format your book title, subtitles and author name in any way you prefer – you 
don't have to use a heading style unless you want the book title in your doc TOC. I 
find that creating and using named paragraph styles in Word saves time and, 
overall,  tends  to  speed  up  your  heading/text  formatting  and  layout  tasks  in 
Word. If you want your book title in your TOC as "Title Page" then you can easily 
implement this in Kindle Create with just one click so there's no need to use a 
heading style for your book title in MS Word.

2. Format the body text or reading text
You can format the reading text in the front matter, chapter text and back matter 
sections of your ebook however you prefer using Word paragraph styles. Again, 
using Word paragraph styles like this will save you time and will speed up your 
text formatting tasks. 

3. Format all your main headings using a single heading style
At a minimum, you should always format all your main headings and chapter 
headings(that will be in your doc TOC) in "Heading 1" style in Word using Quick 
Styles or Change Styles. If you are creating a multi-level or multi-indented TOC 
then you can also use other heading styles as markers for the AutoTOC facility in 
Word.  Word's  AutoTOC feature will  automatically find those headings to help 
create your ebook's single level or multi-level doc TOC. Later, if you prefer, Kindle 
Create will also find and use those same heading styles during Word conversion 
to allow you the option of automatically creating a single level Interactive TOC 
on the Kindle device. See images below:



4. Create a doc TOC
You can create a doc TOC in two ways in MS Word. You can use Word's AutoTOC 
feature  at  References  >  Table  of  Contents  >  Insert  Table  of  Contents to 
automatically create a doc TOC for you. For a step-by-step description of how to 
create  a  doc  TOC  using  AutoTOC –  see  this  link.  You  can  also  use  the 
bookmark/hyperlink method to manually create the TOC item links in your doc 
TOC if you wish. 

5. Add ebook Images
You can add all your ebook images to your Word doc using Insert > Picture in the 
normal way. Later, in Kindle Create, you can easily and safely resize your images 
as necessary with just one click. You can only add and use JPEG images in Kindle 
Create.  If  possible,  your  ebook  images  should always  have  an  original  photo-
capture resolution of at least 300 ppi for best quality – this especially applies to 
fixed format ebooks and paperback books created using KC. It's also worth noting 
that it's far easier and less error prone to add, change remove, replace or resize 
your ebook images in Kindle Create than doing these same tasks in MS Word.

6. Add links and bookmarks
Add all external links as well as internal bookmarks and links as you normally 
would  in  MS  Word  using Insert  >  Bookmark and  Insert  >  Hyperlink 
respectively.

7. Special Kindle formatting requirements(for reflowable ebooks only)
In Word you should set a bookmark within the TOC heading named "toc" on the 
TOC page. The purpose of setting up this bookmark is to ensure that  Table of 
Contentslink  is set up properly in the  Go To  or Navigation Menuon the Kindle 
device. The Cover link in the Go To Menu on the Kindle reader will automatically 
be  set  on  conversion  after  you  have  added  your  Amazon  Product  Image  and 
upload your ebook on KDP.

To ensure that there will be no problems in the Look Inside version(LITB) of your 



ebook in Word click on Home > Change Styles orclick on Home > Quick Styles in 
Word. 

Then  right-click  on  the  "Normal"style.  Click  on  Modify  >  Format  > 
Paragraphand  set  Alignmentto  "Justified"and then  set  no-indent  by  setting 
Specialto "First Line" and Byto "0.01in". See diagram below:



Doing the above will help to avoid or cure the following common problems in the 
Look Inside version of your ebook(on your Amazon product page): 

1. All  reading  text  has  unwanted  indents  throughout.  If  you  are  using 
blocktext paragraphs throughout your ebook, this problem can be cured by 
just modifying the  "Normal" style indent value in Word to  0.01". If you are 
using fiction style for your book then you will also need to create and use a 
paragraph  style  containing  an  indent.  There  are  two  types  of  generally 
acceptable  paragraph  styling  for  ebooks/books.  Either  you  use  blocktext 
style(with no indent) with a space before or space after each paragraph or you 
can use fiction style where the first paragraph of every chapter is not indented 
while all succeeding paragraphs in the chapter have indents. And if you are 
writing a fiction novel rather than a textbook then the fiction style is usually 
the preferred norm. 

2. All centered text and centered headings are wonky and off-centered(also 



caused by unwanted indents). Setting Word's  "Normal" style indent value to 
0.01" as advised above will also remove any unwanted text indents or heading 
indents to cure this problem.

3. All reading text is ragged right(left aligned). Reading text should normally 
be justified. Setting the "Normal" style to "Justified" in Word should cure this 
problem.

4. Spacing  between  end  sections  and  start  sections  is  too  small  or 
inconsistent.  Modifying  the  "Heading  1" style  in  Word  by  adding  a  space 
before value of  "24pts" should cure this problem to give you consistent and 
acceptable spacing between all main sections in the Look Inside version. You 
will also have to create the same spacing for all your individual front matter 
pages – including copyright page, acknowledgements, dedication, other books, 
reviews etc.

See image below:



Setting  the"Normal" style  attribute  as  described  above  explicitly  sets  all  the 
defaults for all Word styles in your document to justify with no-indent because 
"Normal" style attribute  values  are automatically  inherited by all  other  Word 
paragraph styles as their defaults. 

Standard Layouts Used in Books and eBooks
For both ebooks and books there are really only two recognized writing or layout 
styles that  you should use. The first style,  which is normally always used for 
fiction novels, is often simply referred to as "fiction style". This is where the first 
paragraph in a chapter always has no indent while all succeeding paragraphs in 
the  chapter  have  indents.  Then  there  is  another  style  called  "blocktext  style" 
where all the reading text paragraphs are formatted in one way throughout all 
the chapter text in the book – where every paragraph has no indent with a set 
space above or space below that is normally set to between 8pt and 10pt spacing. 
Blocktext style is normally used for textbooks, how-to books, research papers etc. 
My own preference has always been to go with the defined standard for "fiction 
style" and "blocktext style" as described above. For my novels I would always use 
"fiction  style"  and for  my health  books  and how-to books I  would always use 
"blocktext style". Having said all that, I've seen plenty of ebook novels that have 
used "blocktext style" and I've also seen plenty of textbooks that use fiction style. 
So this style decision is really up to you.

How to Prepare and Insert High Quality Images
If  you are  inserting full  page-sized images  for  an ebook,  you could  insert  the 
image into your Word doc using  Insert > Picture in MS Word.  A much better 
option  for  you would be  to insert  your full  page  image into  your book  – at  a 
minimal size of at least 1200 x 1800 pixels(or larger) using Kindle Create which 
enables High Definition Visuals support  for KFX format (see this link for more 
details  on  compliance),  which  would  give  you  higher  HD  image  quality  and 
which would also be much safer and far less error prone than inserting your full-
page image directly into MS Word. 

For  fixed  format  ebooks  and  paperback  books  only,  if  you  want  to  insert 
images(small or large)  onto a page in Kindle Create, for best image quality results 
you  should  always ensure  that  your  image  has  an  original  photo-capture 
resolution  of  300 ppi.  For  example,  if  you have an  original  image  with  a  low 
resolution like 96 ppi then, using a graphics app like Irfanview(free), you should 
increase the image resolution 4 times to 384 ppi without resampling (make sure 
the ppi outcome is always higher than 300 ppi). Then just reduce the ppi to 300 
ppi using linear or bicubic resampling. This method of image preparation should 



always be used for all ebook images in your fixed format ebooks and paperback 
books. Irfanview is also particularly useful for increasing or decreasing  the size 
of  images  with  minimal  image  degradation.  Using  Image  > 
Resizing/Resampling in Irfanview you can double or half the size of an image at 
a set resolution with minimal image degradation, with just one click. See image 
below, which shows the Resize/Resample dialogue window for Irfanview:

For image-dense reflowable ebooks only, you should always try and insert your 
ebook images with a resolution of between 72 ppi and 150 ppi, which will help to 
keep  your  ebook  file  size  reasonably  small  for  upload  to  help  avoid  Kindle's 
monetary download penalty. If you want to prepare smaller images which have 
small-sized  text  on  it  –  such  as  charts  or  a  snip  or  snapshot  of  a  window  or 
window section on a computer – then you will have to use a different method. 
After you have taken the screen snip or window snip, the resolution will probably 
be 96 ppi. Just insert that image – without changing the resolution – onto your 
ebook page in Kindle Create for best quality results.



For fixed format ebooks and image-dense reflowable ebooks,  when you finish the 
above preparation of your ebook images you should then reduce their total file size 
by using the TinyPNG website. TinyPNG will compress all your images by up to 50% 
of their original file size using lossless compression i.e. with no loss in image quality.  
So  if  you  have  an  image-dense  ebook  then  you  should  always  use  the  TinyPNG 
website to reduce image file size in order to avoid Kindle's download penalty which 
will always act reduce your ebook profits. I've used about 60 images of varying sizes  
in this ebook and, after using TinyPNG, the total file size of my ebook is only about 
3.71 Mb, which is  well within Kindle's 5Mb file size limit. 

And just to hammer the point again so you won't forget – you should  always 
insert all your ebook images using Kindle Create – not MS Word – for best image 
quality results. The main reason I keep mentioning this is that your KPF file will 
be converted to KFX format and the KFX specification states that all images in a 
KFX file will have High Defintion Visual support(HDV) -- which is high quality. 
So if you add your images using Kindle Create as advised then HDVsupport will 
always be assured. I've also noticed in my testing that images added to a Word 
doc that has been imported into Kindle Create tend to look fuzzy(lower quality) 
than images that  are directly added to your ebook using Kindle Create.  That's 
really why you should always add your ebook images using Kindle Create – to 
assure proper HDV quality images in your KFX ebook. 

How to Create Lists that Work Well in Kindle Create
Creating Unordered Lists
Some  bad  news  here  I'm  afraid.  Try  as  I  might  I  couldn't  get  unordered  lists 



created in Word to render well in Kindle Create. All the start characters of the 
unordered  list  were  always  vertically  misaligned  which  looks  awful  and  was 
unacceptable. So my advice here is just to use ordered lists instead. There are no 
such problems with ordered lists(see below). 

Creating Ordered Lists
Here's how I create my ordered lists in MS Word for Kindle Create: 

1. Create a list style in Word and call it list-style. Set your preference of font-size 
and space before and space after within this named style.

2. Then use your cursor to highlight all your ordered list block. 

3. Style your list block using list-style.

4. Then click on the Home > Ordered List button and create the ordered list. 

5. Then click on the  Paragraph button or just right-click in the list block and 
choose  "Paragraph" and  ensure  that  Alignment is  set  to  "Justified" and 
Indentation > Left is  set  to  "0". By doing this last step,  your list  indent in 
Kindle Create will default to "0.25in". If you didn't do this step then the indent 
would be "0.5in", which is far too wide or deep for a Kindle Tablet or mobile 
phone.

After you have completed the above, you will also notice that the ordered list will 
not have an indent in Word. Don't worry about this because when you load your 
Word  doc into Kindle  Create,  all  your numbered lists  will  all  have a standard 
indent  of  0.25"by  default.   Also  please  note  that  you  will  not  be  able  to  edit 
ordered lists at all in Kindle Create.

How to Create a Clickable TOC
The best and quickest way to create either a single level or multi-level TOC in MS 
Word is to use MS Word's AutoTOC feature. You can also create a doc TOC using 
the Bookmark/Hyperlink method. 

Before you can use  AutoTOC you should first style all  your headings(and sub-
headings)  that  you  want  to  see  in  your  doc  TOC  using  Word  heading  styles 
because AutoTOC will use these heading styles as markers to select the headings 
for your doc TOC. At a minimum, you should style all  your main headings or 
chapter headings that you want to see in your TOC using "Heading 1"style. This 
will give you a single level or flat TOC when you use Word's AutoTOC facility. If 
you use more than one heading style then  AutoTOC  will give you a multi-level 
TOC.

Here are the necessary steps for creating a clickable doc TOC in Word using the 



AutoTOC facility:

1. Place your cursor where you want the TOC to start on your TOC page.

2. Click on Reference > Table of Contents > Insert Table of Contents.

3. In the new dialogue be sure to deselect or untick  "Show page numbers" and 
select the  Format template that you want to use. I normally just use  "From 
template".

4. Ensure that "Use hyperlinks instead of page numbers" is selected(ticked).

5. Using the  Show levels spin widget,  select the different heading styles to be 
included in your TOC. If you select just h1 then only a single level TOC or flat 
TOC will be created comprising of just headings using  "Heading 1" style. If 
you also choose h2, h3, h4 etc then you will get a multi-level doc TOC provided 
that h2, h3and h4 styles have been used in your Word doc.

6. Use the Web Preview display panel to confirm that you have set up your TOC 
correctly.

7. Then click OK and a doc TOC will automatically be created on your TOC page.

See diagram below:



Another Way to Prepare Tables
If your tables created in MS Word are of poor quality in Kindle Create then try 
converting your tables into images. The easiest way to convert tables to images in 
MS Office is to use MS Excel and MS PowerPoint in the following way:

1. Create your table in MS Excel and save the file. 

2. Open MS PowerPoint and import your Excel spreadsheet.

3. In Powerpoint, resize the table and background to your preference.

4. Export or save your Powerpoint file as a jpeg image. 

5. If required, use a graphics app to resize your image and crop your image to the 
table image boundaries. 

6. Insert the new table image using Kindle Create(not MS Word).

You can also directly convert your Excel spreadsheet to jpeg image using one of 
the many online converters like Zamzar. And you should always insert your table 
images in Kindle Create because it's easier, safer, less error prone and gives you 
higher quality images rather than inserting your images in MS Word.



Checking Your Word doc Using Kindle Previewer
After you have finished formatting your ebook in MS Word, it's always a good 
idea  just  to  quickly  do  a  final  check  of  your  Word  doc  using  Kindle 
Previewer(KP). Doing this check will give you a much better view of your ebook 
layout on other Kindle devices. To test your Word doc, just open KP and, using 
drag-and-drop, just click on your Word doc file icon and drag it into KP and drop 
it into the app and then check the text, headings, layout, TOC, links and metadata 
of  your  converted  Word  doc  in  KP  to  make  absolutely  sure  that  there  are  no 
glaring errors before loading your Word doc into Kindle Create.  

Saving Your Work
After you've finished formatting and checking your Word doc you should make 
sure that you save your Word doc to a safe location. You could just save your 
Word  doc  to  your  computer's  hard  drive  but  a  much  better  and  safer  option 
would be to save your work to DropBox, Google Drive or to an external hard drive 
just in case your computer suddenly crashes or dies and you lose all your data. 

Word Formatting vs. KC Formatting
I thought that it would be both fun and educational just to compare these two 
apps according to which task is better suited to which application. I've broken it 
down into two simple lists which basically define which app is quicker or easier 
with a particular editing or layout task:

MS Word is best at:
1. Formatting headings and text quickly using paragraph styles.

2. Adding external and internal links

3. Adding bookmarks

4. Adding a multi-level doc TOC

5. Adding footnotes, endnotes and tables.



6. Fixing LITB issues.

Kindle Create is best at:
1. Adding theme fonts.

2. Adding, resizing, replacing and removing ebook images

3. Adding/adjusting horizontal spacing, vertical spacing and indents

4. Adding  stylish  dropcaps,  separators,  first-paragraph-no-indent,  blockquotes 
etc

5. Adjusting character styling.

6. Adding a single level doc TOC(not a multi-level or multi-indented TOC)

7. Adding a Logical TOC or Interactive TOC

Kindle Create also suffers from one other big drawback. For instance, if you have 
to change or adjust the font, font color and font size of all your main headings in 
Kindle Create then you will have to implement all these changes manually and 
individually to each ebook heading on a one-by-one basis throughout your ebook 
in  KC.  And  that's  because  KC  does  not  use  named  paragraph/heading  styles. 
Whereas in MS Word, after creating and applying a heading style, all you would 
have to do is just make all these heading changes once in the relevant heading 
style  and  it's  done.  That's  also  why  I  advise  that  it's  always  best  practice  to 
completely format your ebook properly using paragraph/heading styles in Word 
before loading it into Kindle Create. Because doing it using paragraph/heading 
styles in Word is so much easier and quicker in MS Word than doing the same 
styling tasks in KC, so this advice should hopefully save you a lot of time.

Word Formatting Tips
1.   Make sure that you fully format your ebook/book in MS Word – to the max!!  
That means that your book in Word should look exactly the way you want it to 
look  in  your  Kindle  ebook.  And  you  should  always  use  paragraph  styles 
throughout your Word doc to define the styling of all main headings, text and 
spacing in your ebook. Doing it this way, using Word paragraph styles, helps to 
greatly reduce the number of Kindle Create tasks and will make all  remaining 
tasks much easier and quicker to complete in Kindle Create. 

2.   Ensure that you learn and apply the Kindle formatting guidelines or rules for 
MS Word. If you don't do this then I promise that you will have problems.

3.   Remember that it's much easier to add and resize all your ebook images in 
Kindle Create. It's also far quicker to safely add, remove, replace or resize images 



in Kindle Create rather than doing these same tasks in MS Word. 

4.   I always set a default font size of "12pt" for all my reading text in Word(using 
the  "Normal" style).  This  is  the  normal  default  font  size  for  reading  text  in 
ebooks. For print books the normal font size for reading text is usually "11pt". 

5.   When I create lists for Kindle Create, I always create a single generic list style 
in Word for my ordered lists as described in this chapter. I always use  "11.5pt" 
font size with a space before of "6pt" in my list style. Using smaller text size like 
this helps to distinguish lists from the reading text and also helps to gently make 
them stand out. I also think that doing lists this way looks more professional as 
well.  



CHAPTER 3

Preparing a Word Doc Using LibreOffice Writer

Since both LibreOffice Writer(LW) and OpenOffice Writer(OW) have the same 
layout and behavior, the workflow descriptions in this chapter will apply to both 
LW and OW. And from this point on I will only be describing how to format a 
Word doc just using LibreOffice v6.2. I would also advise that the reader use the 
most up-to-date versions of LW or OW to avoid any problems.

I have also assumed that the reader is a LW user who is already well acquainted 
with the layout, behavior and usage of LibreOffice Writer and so I will only be 
giving a general workflow overview of how to prepare a Word doc for KC using 
LibreOffice Writer.

Kindle Create users should also be aware that it doesn’t matter whether you are 
preparing  a  reflowable  ebook,  a  fixed  format  ebook  or  a  paperback  book,  the 
initial preparation of your Word doc using LW, in terms of formatting, styling 
and layout, will be exactly the same for Kindle Create. 

What  follows  in  this  section is a  step  by  step  overview  which  will  show  the 
reader  how  to  properly  prepare  their  Word  doc  using  LibreOffice  Writer  for 
Kindle Create. 

Here  is  a  brief  overview  of  the  formatting  and  layout  tasks  you  will  have  to 
complete in LibreOffice Writer:

1. Format the book title and subtitle elements on the title page.



2. Format the ebook's body text or reading text.

3. Format all major headings and chapter headings using a single heading style. 

4. Create a multi-level(multi-indented) TOC or a single level doc TOC.

5. Add ebook images(optional).

6. Add internal and external links. 

7. Add special Kindle formatting requirements.

Detailed Workflow
What  follows  is  an  overview  of  how  you  should  format  your  Word  doc  in 
LibreOffice Writer:

1. Format your book title
Format your book title, author name, subtitles etc in any way you prefer – you 
don't have to use a heading style. I find that creating and using named paragraph 
styles  in  LW  saves  time  and,  overall,  tends  to  speed  up  your  heading/text 
formatting and layout tasks in LW. If you want your book title in your ebook TOC 
as "Title Page" then you can easily implement this in Kindle Create with just one 
click,  so  there's  no  need  to  use  a  heading  style  now  for  your  book  title  in 
LibreOffice Writer. How to do this is also fully described later in Chapter 4.

2. Format the body text or reading text
You can format the reading text in the front matter, chapter text and back matter 
of your ebook using paragraph styles in LW. Again, using paragraph styles like 
this will save you time and will speed up your text formatting tasks. 

3. Format all your main headings using a single heading style
At a minimum, you should always format all your main headings and chapter 
headings(that  will  be  in  your  doc  TOC)  in  "Heading  1" style  from  the Styles 
panel. If you are creating a multi-level or multi-indented TOC then you can also 
use  other  heading  styles  as  markers  for  the  AutoTOC facility  in  LW.  The 
AutoTOC feature  will  automatically  find  those  headings  to  help  create  your 
ebook's single level or multi-level doc TOC. Later, if you prefer, Kindle Create will 
also find and use those same heading styles during Word conversion to allow you 
the option of automatically creating a single level Interactive TOC on the Kindle 
device. See image below:



4. Create a doc TOC
You can create a doc TOC in two ways in LibreOffice Writer(LW). You can click 
Insert > Table of Contents and Index > Insert Table of Contents, Index etc  to 
automatically create a doc TOC for you.   For a detailed explanation of how to 
create a clickable TOC using the AutoTOC facility in LW – see this link. You can 
also use the bookmark/hyperlink method to manually create the TOC item links 
in your doc TOC if you wish. 

5. Add ebook Images
You can add all your ebook images to your LW doc using Insert > Image in the 
normal way. Later, in Kindle Create, you can easily and safely resize your images 
as necessary with just one click. Also remember that you can only add and use 
JPEG  images  in  Kindle  Create.  And,  whenever  possible,  your  ebook  images 
should always have an original photo-capture resolution of at least 300 ppi for 
best  quality  –  this  is  certainly  a  must for  fixed  format  ebooks  and paperback 
books created using KC. It's also worth remembering that it's far easier and less 
error prone to add, change remove, replace or resize your ebook images in Kindle 
Create rather than doing these same tasks in MS Word.

6. Add links and bookmarks



Add all external links as well as internal bookmarks and links as you normally 
would in LW using Insert > Bookmark and Insert > Hyperlink respectively.

7. Special Kindle formatting requirements(for reflowable ebooks only)
In LibreOffice Writer you should set a bookmark within the TOC heading named 
"toc" on the TOC page. The purpose of setting up this bookmark is to ensure that 
Table of Contentslink is set up properly in the Go To or Navigation Menuon the 
Kindle device. By the way, the Cover link in the Go to Menu on the Kindle reader 
will  automatically  be  set  on  conversion  after  you  have  added  your  Amazon 
Product Page image and uploaded your ebook on KDP.

To ensure that there will be no problems in the Look Inside version(LITB) of your 
ebook click on the Styles buttonin LW.

Then  right  click  on  "Default  Style" and  select  the  Modify  >  Indents  and 
Alignment taband set Alignmentto "Justified". See diagram below:



In the Indents & Spacing tab set no-indent by setting Indent > First Line to 
0.01". See diagram below.

Doing the above will help to avoid or cure the following common problems in the 



Look Inside version of your reflowable ebook: 
1. All  reading  text  has  unwanted  indents  throughout.  If  you  are  using 

blocktext paragraphs throughout in your ebook, this problem can be cured by 
just  modifying the  "Default  Style" indent  value in LW to  0.01".  If  you are 
using  fiction  style  in  your  book  then  you  will  also  need  to  create  and  use 
another  paragraph  style  containing  an  indent.  There  are  two  types  of 
generally  acceptable  paragraph  styling  for  ebooks/books.  Either  you  use 
blocktext style(with no indent) throughout your book with a space before or 
space  after  each  paragraph  or  you  can  use  fiction  style  where  the  first 
paragraph of every chapter is not indented while all succeeding paragraphs in 
the  chapter  have  indents.  Blocktext  style  is  normally  used  for  non-fiction 
publications like textbooks, how-to books, research papers etc. But if you are 
writing  a  novel  rather  than  a  textbook  then  fiction  style  is  usually  the 
preferred norm. 

2. All centered text and centered headings are wonky and off-centered(also 
caused  by  unwanted  indents).  Setting  the  "Default  Style" indent  value  to 
0.01" as advised above will also remove any unwanted text indents or heading 
indents to cure this problem.

3. All  reading  text  is  ragged  right(left  aligned) and  should  normally  be 
justified.  Setting  the  Default  Style style  to  "Justified" should  cure  this 
problem.

4. Spacing  between  end  sections  and  start  sections  is  too  small  or 
inconsistent. Modifying the Heading 1 style in LW by adding a space before 
paragraph  value  of  between  "24pts" should  cure  this  problem  to  give  you 
consistent  and  acceptable  spacing  between  all  main  sections  in  the  Look 
Inside version of your ebook. You will also have to create the same consistent 
spacing  for  all  your  individual  front  and  back  matter  sections  –  including 
copyright page, acknowledgements, dedication, about the author, other books, 
reviews etc. See below.



Setting the  "Default Style" style attributes as described above explicitly sets all 
the defaults for all the styles in your document to text justified with no-indent 
because all the "Default Style" attribute values will automatically be inherited by 
all other paragraph styles as their default values.

Standard Layouts Used in Books and eBooks
For both ebooks and books there are really only two recognized writing or layout 
styles that  you should use. The first style,  which is normally always used for 
fiction novels, is often simply referred to as "fiction style". This is where the first 
paragraph in a chapter always has no indent whereas all succeeding paragraphs 
in  the  chapter  will  have  indents.  Then  there  is  another  layout  style  called 
"blocktext style" where all the reading text paragraphs are formatted in one way 
throughout  all  the  chapter  text  in  the  book  –  where  every  paragraph  has  no 
indent with a set space above or space below that is normally set to between 8pt 
and  10pt spacing. Blocktext style is normally used for textbooks, how-to books, 
research papers etc. My own preference has always been to go with the defined 
standard for "fiction style" and "blocktext style" as described above. For my novels 
I would always use "fiction style" and for my health books and how-to books I 
would always use "blocktext style". Having said all that, I've seen plenty of ebook 
novels that have used "blocktext style" and I've also seen plenty of textbooks that 
use fiction style. So this layout style decision is really up to you.

How to Prepare and Insert High Quality Images
If you are inserting full page-sized images, you could insert the image into your 



document using Insert > Image in LW. A much better option would be to insert 
your full page image into your book – at a minimal size of at least 1200 x 1800 
pixels(or larger) enabling  High Definition Visuals  for KFX format using Kindle 
Create(see this link for details), which would also be much safer and far less error 
prone than inserting your full-page image in MS Word. 

For fixed format ebooks and paperback books, if you want to insert images(small 
or large)  onto a page in Kindle Create, for best image quality results you should 
always ensure that your image has an original photo-capture resolution of 300 
ppi. If you have an original image with a low resolution like 96 ppi then, in a 
graphics app like  Irfanview(free), you should increase the image resolution by 
multiplying by 4 to 384 ppi without resampling (make sure the ppi outcome is 
always higher than 300 ppi). Then just reduce the resolution to 300 ppi using 
linear or bicubic resampling. This method of image preparation should always be 
used  for  all  ebook  images  in  your  fixed  format  ebooks  and  paperback  books. 
Irfanview is also particularly useful for increasing the size of images, at a set 
resolution,  with  minimal  image  degradation.  Using  Image  > 
Resizing/Resampling in Irfanview and with just one click you can double or half 
the  size of  an image  at  a  set  resolution  with  minimal  image  degradation.  See 
image below, which shows the Resize/Resample dialogue window for Irfanview:



For reflowable ebooks only, you should always try and insert your ebook images 
with a resolution of between 72 ppi and 150 ppi, which will help to keep your 
ebook  file  size  reasonably  small  for  upload  to  help  avoid  Kindle's  download 
penalty. If you want to prepare smaller images which have small-sized text on it – 
such  as  charts  or  a  snip  or  snapshot  of  a  window  or  window  section  on  a 
computer – then you will have to use a different method. After you have taken 
the screen snip or window snip, the resolution will probably be 96 ppi. Just insert 
that image – without changing the resolution – onto your ebook page in Kindle 
Create for best quality results.

For image-dense reflowable and fixed format ebooks only, when you finish the above 
preparation of your ebook images you should then reduce their total file size by using 
the TinyPNG website. TinyPNG will compress all your images by up to 50% of their 
original file size using lossless compression i.e. with no loss in image quality. So if 
you have an image-dense ebook then you should use the TinyPNG website to reduce 
image file size in order to avoid Kindle's download penalty which will reduce your 
ebook  profits.  I've  used  42  images  of  varying  sizes  in  this  book  and,  after  using 
TinyPNG, the total file size of my ebook is only about 2.29 Mb, which is  well within  
Kindle's 5Mb file size limit. 



And just to hammer the point again so you won't  forget – you should  always 
insert all your ebook images using Kindle Create – not LibreOffice Writer  – for 
best image quality results. The main reason I keep mentioning this is that your 
KPF file will be converted to KFX format and the KFX specification states that all 
images in a KFX file will have  High Defintion Visual support(HDV) -- which is 
high quality. So if you add your images using Kindle Create then  HDV support 
will  always be assured. I've also noticed in my testing that images added to a 
Word doc that has been imported into KC look more fuzzy(lower quality) than 
images that are directly added into your ebook using Kindle Create. That's really 
why you should always add your ebook images using Kindle Create – to assure 
properhigh quality HDV images in your KFX ebook. 

Creating Lists that Work Well in Kindle Create
Creating Unordered Lists
Some  bad  news  here  I'm  afraid.  Try  as  I  might  I  couldn't  get  unordered  lists 
created in Word to render well in Kindle Create. All the start characters of the 
unordered list were always vertically misaligned which looked awful and was 
unacceptable. So my advice here is just to use ordered lists instead. There are no 
such problems with ordered lists(see below). 

Creating Ordered Lists
1. In LW, create a list style and name it list-style and set your own preference of 

font-size and vertical spacing within this named style.

2. Then, using your cursor, highlight your whole ordered list block. 



3. Style your list block using list-style.

4. Then click on the Ordered List button and create the ordered list. 

5. Next,  right-click  and  choose  Paragraph>Indents  and  Alignment  tab and 
ensure that Alignment is set to "Justified" and  Indentation > Left is set to "0". 
By  doing  this  last  step,  your  list  indent  in  Kindle  Create  will  default  to 
"0.25in". If you didn't do this step then the indent would be "0.5in", which is 
far too wide or deep for a Kindle Tablet or mobile phone.

After you have completed the above, you will also notice that the ordered list will 
not have an indent in LW. Don't worry about this because when you load your 
LW-derived Word  doc into Kindle  Create,  all  your numbered lists  will  have a 
standard indent of 0.25"by default.  Also please note that you will not be able to 
edit ordered lists at all in Kindle Create.

How to Create a Clickable TOC
This description applies to both LW and OW since both these apps have virtually 
the  same  app  layout  and  behavior.  I  also  know  that  many  new  or  first-time 
LibreOffice  Writer  users  and  OpenOffice  Writer  users  usually  have  major 
problems with creating a clickable doc TOC using the AutoTOC facility, which is 
why I've included a detailed description of how to create a doc TOC with links 
here:

1. Place your cursor where you want your doc TOC to start on your TOC page.

2. In LibreOffice Writer, click on Insert > Table of Contents and Index > Table 
of Contents, Index or Bibliography.

3. In  the  new  dialogue,  in  the  Type  tab,  set  Title to  "Table  of  Contents" or 
"Contents",  set the  Type dropdown to  "Table of Contents" and then finally 
deselect or untick "Protected against manual changes". Doing this just allows 
you to edit the TOC in your document after TOC creation.

4. Then click on the Entries tab.

5. Select h1("Heading 1" style)in the Level columnat top left. 

6. Then click on the"T" button and just press the Delete key on your keyboard. 
This will remove all the tabbed dots for all h1 entries in your TOC. Check that 
this is the case in the right hand preview panel.

7. Now click on the "#" button and press the Delete key on your keyboard. The 
page numbers will be removed from all  h1 entries in your TOC. Again check 
that this is the case in the right hand preview panel.

8. Now just repeat the above for all the other heading levels(i.e.  h2, h3, h4 etc) 



that you want to include in your clickable doc TOC.

9. When you've finished creating your TOC, click  "OK" and your clickable TOC 
will automatically be created on your selected TOC page. If you have only used 
"Heading 1"(h1) style then you will just get a clickable single level or flat doc 
TOC. But if you've also used and included h1, h2, h3, h4 etc then you will get a 
clickable multi-level(or multi-indented) doc TOC. 

See diagram below:

Saving Your Work
After  you've  finished  formatting  your  book  in  LibreOffice  Writer  you  should 
make sure that you save it as a Word doc to a safe location. You could just save 
your Word doc to your computer's hard drive but a much better option would be 
to save your work to DropBox, Google Drive or to an external hard drive just in 
case  your computer  suddenly crashes or  becomes unusable  –  and you lose all 
your data. 

Checking Your Word doc Using Kindle Previewer
After you've finished formatting your ebook in LibreOffice Writer and saved it as 
a Word docx file, it's always a good idea just to quickly test and check your Word 
doc using Kindle Previewer(KP) standalone app. Doing this will give you a much 
better view of your ebook layout on other Kindle devices. To test your Word doc, 
just open KP and, using drag-and-drop, just click on your Word doc file icon and 
drag it into KP and drop it into the app and then check the text, headings, layout, 



TOC, links and metadata of your converted Word doc in KP to make absolutely 
sure  that  there  are  no glaring errors  in  your Word  doc  before  loading  it  into 
Kindle Create.  

LibreOffice Formatting vs. KC Formatting
I thought that it would be both fun and educational just to compare these two 
apps according to which task is better suited to which application. I've broken it 
down into two simple lists which basically define which app is quicker or easier 
with a particular editing or layout task:

LibreOffice Writer is best at:
1. Formatting headings and text quickly using paragraph styles.

2. Adding external and internal links.

3. Adding bookmarks.

4. Adding a multi-level doc TOC.

5. Adding footnotes, endnotes and tables.

6. Fixing LITB issues.

Kindle Create is best at:
1. Adding theme fonts.

2. Adding, resizing, replacing and removing ebook images.

3. Adding/adjusting horizontal spacing, vertical spacing and indents.

4. Adding  stylish  dropcaps,  separators,  first-paragraph-no-indent,  blockquotes 
etc.

5. Adjusting character styling.

6. Adding a single level doc TOC(not a multi-level or multi-indented TOC).

7. Adding a Logical TOC or Interactive TOC.



Kindle Create also suffers from one other big drawback. For instance, if you have 
to change or adjust the font, font color and font size of all your main headings in 
Kindle Create then you will have to implement all these changes manually and 
individually to each ebook heading on a one-by-one basis throughout your ebook 
in  KC.  And  that's  because  KC  does  not  use  named  paragraph/heading  styles. 
Whereas in MS Word, after creating and applying a heading style, all you would 
have to do is just make all these heading changes once in the relevant heading 
style  and  it's  done.  That's  also  why  I  advise  that  it's  always  best  practice  to 
completely  format  your  ebook  properly  and  thoroughly  as  you  can  using 
paragraph/heading styles in Word before loading it into Kindle Create. Because 
doing it using paragraph/heading styles in Word is so much easier and quicker in 
MS Word than doing the same styling tasks in KC, so this advice should hopefully 
help save you a lot of time.

LibreOffice Writer Formatting Tips
1.   Make sure that you fully format your ebook/book in LibreOffice Writer(LW) – 
to the max!! That means that your book in LW should look exactly the way you 
want it to look in your Kindle ebook. And you should always use paragraph styles 
throughout to define the styling of all main headings, text and spacing in your 
ebook.  Doing  it  this  way,  using  paragraph  styles,  helps  to  greatly  reduce  the 
number of KC tasks and will make all remaining tasks much easier and quicker to 
complete in Kindle Create. 

2.   Ensure that you learn and apply the Kindle formatting guidelines or rules for 
Word.  You should  also  apply  these  same guidelines when  you are formatting 
your  ebook  in  LW.  If  you  don't  do  this  then  I  promise  that  you  will  have 
problems.

3.  Remember that it's much easier to add and resize all your ebook images in 
Kindle Create.  It's  also far easier and quicker to safely add,  remove,  replace or 
resize images in Kindle Create than doing these same tasks in LW. 

4.  I always set a default font size of "12pt" for all my body text or reading text in 
LibreOffice  Writer(using  the  "DefaultStyle").  This  is  normally  the  accepted 
default size of your reading text in ebooks. For paperback books the normal font 
size for reading text is usually "11pt". 

5.  Whenever I create a list in KC, I always usually create a single generic list style 
in LW for my ordered lists as described in this chapter. I always use "11.5pt" font 
size with a space before of "8pt" in my list style. Using a slightly smaller text size 
helps to distinguish lists from the reading text and helps to gently make them 
stand out. I also think that doing it this way looks more professional as well.  



PART III

Using Kindle Create



CHAPTER 4

Create a Reflowable eBook

In this chapter, I will be describing in detail how to load a Word doc into KC and 
how to format your ebook to create a reflowable ebook as a KPF file for upload to 
KDP. This will more or less be described(with options) in a detailed step by step 
manner.

What follows is a step by step detailed guide on how to load your Word doc into 
Kindle  Create  in  order  to  complete  any  final  formatting  or  layout  tasks.  This 
description  also  assumes  that  you  have  already  followed  and  completed  the 
formatting and styling of your Word doc as advised in Chapter 2.

If you are planning to release your novel on Amazon as both an ebook and as a 
paperback, then you should always prepare your reflowable ebook version first in 
KC and then create your paperback version in KC afterwards. If  you do it this 
way,  as  you  will  discover,  preparing  your  paperback  book  will  be  greatly 
simplified and quick because you can actually use your ebook's KCB project file 
version(which has already been formatted and prepared properly in KC) to create 
your paperback version in Kindle Create thus saving yourself a whole lot of time 
and effort.

And because you should have done all the formatting necessary in your Word 
doc already, then any formatting/layout tasks that still need to be done in Kindle 
Create will be kept to a glorious minimum. 



In Kindle Create you will be able to do all the same editing and layout tasks as in 
MS Word with the following exceptions:

1. You will not be able to create or edit endnotes.

2. You will not be able to create or edit tables.

3. You will not be able to create or edit lists.

As  an  overview,  you  will  need  to  complete  the  following  tasks  to  create  a 
reflowable ebook in KC:
1. Create a new Kindle Create project.

2. Load a properly prepared Word doc into KC.

3. Create a Logical TOC(aka Interactive TOC).

4. Choose and add a theme font according to your ebook's genre.

5. Reformat or adjust your book title on your title page.

6. Reformat or adjust all ebook main headings and chapter headings as you prefer. 

7. Add, remove or edit internet hyperlinks.

8. Add, change, replace, resize or remove images.

9. Using other formatting widgets in the Text Properties > Elements tab.

10.Please also take note that you shouldn't have to touch or change the formatting of 
your ebook's body text or reading text, which should already have been properly 
formatted in your Word doc.



Detailed Workflow
Here are the steps needed for finishing off your reflowable ebook in Kindle Create:

1.   Create a New Project
Open the Kindle Create app and, in the  Start window, click on the  NewProject 
from File button. See diagram below.

2.   Loading your Word doc into Kindle Create
In the new  File Selection dialog, select the book type and select  Novel, Essays 
etc, choose the ebook language from the Content Language dropdown and then 
click on the Choose Filebutton to select your Word doc. See diagram below:



The  KC  application  will  open  showing  the  Kindle  Create  main  application 
window. See diagram below:



3.   Create the Interactive TOC
When  you  first  open  the  main  KC  app  window,  there  will  be  a  small  dialog 
window at top left called  Suggested Chapter Titles. This window helps you to 
create the Interactive TOC on the Kindle device(this has nothing to do with the 
doc TOC). This must be a single level TOC i.e. not a multi-level, multi-indented 
TOC because you cannot create a multi-level TOC in KC.  TheSuggested Chapter 
Titles window dialog will display all headings that use a heading style as already 
selected(ticked)  in  KC.  To  create  your  preferred  Interactive  TOC,  you  must 
deselect any headings that you do not want to see in the  Interactive TOC or in 
your KC-generated doc TOC. After you've done that just click the Accept Selected 
button. This automatically creates your Interactive TOC and sets up the chapter 
heading  sections  of  your  ebook/book.  For  more  details  on  how  to  create  the 
Interactive TOC see this link. 

See diagram below:



You  can  also  click  on  a  section  in  the  Control  panel and  then  use  the  Text 
Properties > Elements tab > Common Elements > Chapter Title button to add or 
update  that  chapter  heading  to  your  Interactive  TOC.  See  this  link for  more 
details.

Note: In Kindle Create, if you want to change the case of your headings in theKC 
TOC to allcaps, then just physically re-type the headings in capital letters in the 
Kindle Create editor. Do this for all your headings. Then, when you create your 
Interactive TOC or doc TOC, all chapter headings will be in capitals. And exactly 
the same method applies if your want to change your chapter headings to title 
case.

4.   Creating your TOC page in KC
You have the option of either using the doc TOC that you created in Word or you 
can create a doc TOC created in Kindle Create which will only be a single level 
TOC  and  which  will  look  exactly  the  same  as  your  Interactive  TOC.  In  the 
toolbar, click on Insert > Table of Contents or just right click on a section in the 
Contents panel and select  Insert Table of Contents and a single level doc TOC 
will automatically be created on the new page above your selected section. See 
diagram below.



4.   Choose and add a theme according to your book's genre
Click on the  Theme button on the RHS of the top Toolbar and a  Themes dialog 
will appear where you can select a particular theme for your ebook's genre. There 
are four available themes: Modern, Classic, Cosmos, Exo and Amour.

5.   Reformat or adjust the book title formatting
Highlight your book title with your cursor and then click on the Text Properties 



>Elements tab > Page Titles > Book Title button. Doing this ensures that a link 
to your book title called "Title Page" is inserted at the top of your Interactive TOC 
and KC-generated doc TOC. In the KC Editor, click and highlight the book title on 
the book title page and click on the Text Properties > Formatting tab. Using the 
widgets on this  tab,  you can now change font, adjust font styling,  layout and 
paragraph styling etc of the book title text to your own preference. 

6.   Add, remove or edit internet hyperlinks
You can now add or edit internet links in KC by right-clicking on highlighted text 
and selecting Insert Hyperlink. See diagram below: 

7.   Reformat or adjust all ebook headings
The ebook headings will normally always need to be formatted again because KC 
will  implement its  own default  theme font heading formatting with different 



fonts and spacing which probably won't suit you. You should also appropriately 
use  "Book  Title",  "Chapter  Title",  "Chapter  Subtitle",  "Part  Title"and"Part 
Subtitle"in the Text Properties > Elements tab to format all the main headings 
in your ebook or book. As above,  you will  also have to reformat each heading 
individually  to  your  own  preference  using  the  styling  widgets  in  the  Text 
Properties  > Formatting  tab in  order  to change  the  font/paragraph  stylng to 
your  own  formatting  preference. For  more  important  details  on  heading 
formatting see this link. 

8.   Reformat or adjust body text
You should have already formatted all the body text or reading text in MS Word. 
You can reformat the body text however you like using the formatting widgets in 
the  Text Properties > Elements tab and  Formatting tab but do  not change the 
font face.

9.   Adjusting Horizontal and Vertical Spacing
Use the widgets at Text Properties > Formatting tab > Indents to adjust all space 
for margin left, margin right and indents in Kindle Create. You can also use the 
widgets at  Text Properties > Formatting tab > Spacing to adjust  margin top, 
margin bottom and line spacing values.

10.  Add, change, resize, replace or remove images
This is probably one of the best features of KC. It really is a breeze to add, replace, 
resize  and remove  images  or  add  "alt"  text  to  any  image  in  your ebook  using 
Kindle Create. The resizing feature is simplicity itself to use – you can resize your 
selected image with just one click, with resizing choices that range from logo size 
to full screen width. To format the image, click on the image in the Editor and use 
the formatting widgets in the Image Properties panel on the RHS. Currently, you 
can only add and use JPEG images in your Kindle Create doc. See diagram below.



11.  Add dropcaps(optional)
To apply a dropcap at the start of a paragraph, put your cursor at the start of the 
paragraph  and just tick the tickbox  at  Text Properties > Formatting > Apply 
Drop Cap. See diagram below:

12.  Add separators(optional)
To add a separator, in the KC Editor, put your cursor on the blank line where you 



want  the  separator  and  then  click  on  the  Text  Properties  >  Elements  tab  > 
Separator button. See diagram below:

13.  The Text Properties > Elements tab > Common Elements section allows you 
to format all common heading elements of your book by appropriately swiping 
the heading or placing your cursor and clicking on the appropriate button. This 
section allows you to format the Chapter Title, Chapter Subtitle, Chapter First 
Paragraph(with dropcap) and Separator.

14.   The  Text Properties  > Elements tab > Page  Titles section  allows you to 
format other title elements of your book by appropriately swiping the heading or 
subtitle and clicking on the appropriate button. This section allows you to format 
the  Book Title, Book Subtitle, Author Name, Part Title  and Part Subtitle.  See 
diagram below:



15.  The  Text Properties > Elements tab > Book Start and End Pages section 
allows you to style the front matter and back matter sections of your book. You 
have  the  option  of  using  the  following  styling:  Page  Title,  First 
Paragraph(without  dropcap),  Dedication  section,  Opening  Quote(Epigraph), 
Opening Quote Credit and Copyright Text.

16.  In the  Text Properties > Elements tab > Book Body section allows you to 
format all the elements in the actual chapter sections of your book or ebook. You 
can  style  these elements  using  Chapter Title,  Chapter Subtitle,  Chapter First 
Paragraph(with  dropcap),  Block  Quote,  Poem  and Separator and  you  can 
implement this styling with just a few clicks. See diagram below:



17.  Your formatting is finished!

How to Use the Heading Styles in the Elements Tab
There are two ways to create your TOC(doc TOC and Interactive TOC) in Kindle 
Create. See below.

Creating a TOC using the Suggested Chapter Titles Dialogue
When you first import your Word doc into Kindle Create the Suggested Chapter 
Titles  dialoguewindow will be displayed. All the headings and sub-headings in 
your ebook will already be selected and displayed in this window dialogue. What 
you  must  do  is  deselect(untick)  any  heading  that  is  not  a  main  heading  or  a 
chapter  title  in  your book.  All  selected  headings  will  be incorporated  into  the 
TOC. Then press the  Accept All  button. As a result of doing this, the following 
will happen in your KC doc:

1. The  ebook  contents  will  be  automatically  re-arranged  into  proper  chapter 
sections according to your heading selections in Suggested Chapter Titles.

2. All chapter headings will be formatted in the default or chosen Kindle Create 
theme font. 

3. An  Interactive  TOC  will  automatically  be  created  from  your  selected 
headings.



4. If you create a doc TOC in Kindle Create,  the doc TOC will  look exactly the 
same as the Interactive TOC. And at the moment, you can only create a single 
level or flat TOC in Kindle Create. 

Creating a TOC without using the Suggested Chapter Titles Dialogue
When the Suggested Chapter Titles dialogue comes up just press the Reject All 
button. The display will now only show sections that use page breaks before – 
these headings will not be automatically be included in your TOC. Any section 
that is not included in the TOC will have an orange dot next to it in the Control 
panel and you can now manually add or update individual chapter sections(with 
orange dots) into the TOC on a one-by-one basis by doing the following:

1. In  the  Control  panel,  click  on  a  main  section  or  chapter  section(with  an 
orange dot next to it) that you want to see in your TOC. An orange dot next to a 
heading in the Control panel informs you that that heading is not in the TOC.

2. Then go to Text Properties > Elements tab > Common Elements and click on 
the Chapter Title button. Doing this automatically adds your selected heading 
to both the Interactive TOC and KC–generated doc TOC.

3. Repeat above for all the headings that you want to see in your KC-generated 
doc TOC and Interactive TOC.

Due to a Kindle Create update(v1.27) the KC user can now create or update the 
Interactive TOC by just styling the relevant headings using the following key 
heading style elements in the Text Properties >Elements tab:

1. Book Title

2. Part Title

3. Chapter Title

Using the above buttons to style your headings will also automatically add those 
headings to both the Intractive TOC and KC-generated doc TOC. I always format 
main sections like introduction, preface, foreword and chapter headings for TOC 
inclusion using just the  Text Properties >Elements tab > Common Elements 
>Chapter Title styling button. I also make sure to style the book title using the 
Elements tab > Page Titles > Book Title button. This creates an Interactive TOC 
with just my main headings and chapter headings which also includes a  "Title 
Page" link at the top. And if you create a KC-generated doc TOC, the "Title Page" 
link will be added as well. Also bear in mind that if you use Kindle Create to create 
both your doc TOC and Interactive TOC then you will always get a single level or 
flat TOC. At the moment you cannot create a multi-level(or multi-indented) TOC 
in KC.



It's also advisable to create an  Interactive TOC in KC that only contains main 
chapter headings because all you will ever get in the Interactive TOC is a single 
level or flat TOC. The approach I use is that if users want to see a more detailed 
multi-indented, clickable doc TOC(created In Word) then they can click on the 
Table of Contents link in the Navigation or Go To menu on their Kindle device. 
This keeps the  Interactive TOC neat,  small, useful and easy to create as just a 
single level or flat TOC. And if the device users want a more detailed, multi-level 
TOC with links then they can just click the TOC link on the Kindle device to view 
and use the more detailed multi-level doc TOC links(created in Word) to navigate 
my ebook. 

If you use any of the above key styles in the Elements tab > Common Elements 
to tag your main headings in your Kindle Create doc then they will always be 
included in both the Interactive TOC and in the KC-generated doc TOC and both 
TOCs will  be a single level of flat TOC and will always look the same. 
I've  also  found  that  the  Text  Properties  >  Formatting  tab  >  Set  Font  Face 
settingwas  blank for  any headings  that  were styled using any of  the  heading 
styling buttons in the the  Elements tab in KC. I  don't  know whether this  is a 
glitch or intended by Kindle but this can certainly lead to problems. So you must 
always check that each heading font is correctly set with your appropriate choice 
of font. If you don't do this – and leave it blank -- then the Kindle ereader may not 
show the correct theme font or heading font that you desire across the many 
different types of Kindle ereading devices ‒ it will probably show Georgia font(or 
another default system font) instead on the Kindle device. There is a complex 
html  explanation  for  this  involving  default  system  fonts  and  default  font 
fallbacks which I am not going to describe here because I think that it would just 
confuse  people.  All  you  have  to  remember is  just  make  sure  that  you  always 
check that the correct heading fonts are used for all your main headings across all 
KFX-enabled devices when you test. So just check and make sure that the your 



chosen theme font is correctly set for all your headings in Formatting tab > Set 
Font Face and you should always get the correct heading fonts across all KFX-
enabled  devices  when  you  check  your  chapter  headings  using  KCPreview in 
Tablet   view,  Phone  view and  Kindle  E-reader  view.  This  caveat  applies 
whenever Book Title, Chapter Title and Part Title are used in the Elements tab 
to style relevant headings. 
So  to  recap  and  summarize  you  must,  at  a  minimum,  format  your  chapter 
heading styles in KC in the following way:
1. Use the Suggested Chapter Titles dialogue to initially create the chapter heading 

sections in your ebook and in your Interactive TOC and KC-generated doc TOC.

2. Or you can use  Elements tab > Common Elements > Chapter Title button to 
individually add or update chapter headings in your KC-generated doc TOC and 
Interactive TOC.

3. Use the Elements tab > Page Titles > Book Title button to add the "Title Page" in 
your Interactive TOC and in KC-generated doc TOC.

4. You must also always check your chapter headings and ensure that your chosen 
theme font or chapter heading font in  Text Properties > Formatting tab >Set 
Font Face is properly set and will actually show in your ebook-for-sale across all  
KFX-enabled devices – you can use  KC Preview or  Kindle Previewer for these 
checks.

5. There is also a current bug in Kindle Create where, after importing your Word doc 
into Kindle Create, all centered headings may be wonky and off-centered.  This 
problem will not show in KC Preview or Kindle Previewer but this problem will 
certainly show in the Look Inside version of your ebook. To avoid or resolve this 
issue and for every centered heading, you must visually check and ensure that 
the margin left and margin right widget values at Text Properties > Formatting 
tab > Indents(top row) are always set to  "0.00". You must do this check for all 
your main headings.   

How to Reduce Total File Size
The total file size of the images in your ebook is quite important because Amazon 
Kindle currently charges a profit penalty of $0.15 per Mb over their standard file 
size limit of 5 Mb for all the ebook images in your ebook. So if you have a 100 page 
book with 100 large images then you will probably get zero profit if you choose 
KDP's 70% profit option. The only way for you to make a profit would be to take 
the 35% profit option, which will only give you a small profit.

To help protect your 70% profit option and reduce the total profit penalty of your 
image-dense  ebook,  you  should  always  use  a  good  image  file  compression 



application. One of the best free image file compression apps that I've used is a 
free  online  compression  app  called  TinyPNG.  This  app  is  capable  of  reducing 
your total image file size by up to 50% with very little loss in image quality(using 
lossless compression). You can even upload and process all your ebook's images 
at once in a single batch run.  

In all instances of the above you should always avoid adding ebook images in MS 
Word. You should instead add all your ebook images using Kindle Create because 
it's quicker, easier, less error prone and gives you higher quality images.

Manipulating Text, Pages and Sections
You can use the following methods  to manipulate  text,  pages and sections  in 
Kindle Create:

1. In Kindle Create, you can create a page-break on a page by placing the cursor at 
the split then right-click and choose"Split chapter here".

2. If you want to create a new blank page, in the KC Editor place your cursor to the  
right of the last character at the bottom of a page then right-click and choose 
"Split chapter here" and a new blank page will automatically be generated below 
your selected page.  

3. You can merge two sections  into  one(or  remove the page-break)  by clicking  a 
chapter section in the Contents panel and then choosing  "Merge with Previous 
Section" or "Merge with Next Section".

4. You can now move whole sections or chapters within the  Contents panel to a 
different position in your book just using drag-and-drop.

5. To remove a section,  right-click on a section in the  Contents panel  and select 
"Delete Section".

6. To move text in KC, copy the text in the page or section using  Ctl-X.  Place the 
cursor where you want the new text to start then paste it into the new location 
using Ctl-V.

7. To delete text on a page, swipe and highlight the relevant text on the page and 



press  the  Backspace key or  Delete key on your keyboard and the text  will  be 
removed.

8. If  you want to add text,  a  page of text or whole section from your Word doc, 
highlight all the text with your cursor and use Ctl-C to copy it from your Word 
doc to the Clipboard then just paste it onto the appropriate page in your KC doc 
using Ctl-V as normal. Bear in mind that you will probably also have to reformat 
or restyle the newly added text, page or section in KC as well.

9. And if you goof and do something wrong, just use Ctl-Z to go back a step to undo 
the formatting.

How to Format Poetry
There are only three ways to format poetry in an ebook or book using KC. The 
first way is easy – just center all your stanzas. The second method involves using 
left text alignment for all your stanzas and then you can individually set and vary 
the indents per line as you prefer in Kindle Create. The only other way to, say, 
have your poetry both left aligned and centered on a page is to use a graphics app 
like Adobe Photoshop or GIMP(free) and to create and use cropped jpeg images of 
your left aligned stanzas(with special indenting added per line as you like) and 
then you can align all the stanza images centrally in your ebook when you add 
them to the page in Kindle Create.

Understanding the Look Inside Version of Your eBook
When  you  upload  your  reflowable  ebook  to  Amazon  Kindle,  many  files  are 
created from your single upload file. These other file versions of your ebook are 
created  to  accommodate  all  the  different  operating  systems  that  run  Kindle 
ereader software. So you will have different file versions of your ebook for OSX, 
Windows and Android.  Then there are the various older and newer operating 
system versions for Kindle including KF7, KF8 and KFX.  Finally, an html file is 
also  created  for  the  Look  Inside  version(LITB)  of  your  ebook  on  your  ebook 
product page. This file is an html file. So what will you see in your LITB version? 
You will see a certain percentage(usually 10%) of your ebook pages displayed in 
html format.  There will  also be no page-breaks in the  LITB version.  The LITB 
version also uses cascading stylesheets that may force unwanted styling defaults 
on your ebook if it hasn't been formatted in the proper way, which could cause 
problems  like  ragged  right(left  align)  throughout  your  ebook  reading  text, 
incorrect spacing between end sections and start sections as well as unwanted 
indents throughout your reading text which also causes off-centered problems 
for centered text and headings. These LITB problems and how to avoid or resolve 
them are all dealt with in more detail in  Chapter 2 – Detailed Workflow(for MS 



Word) or Chapter 3 – Detailed Workflow(for LibreOffice Writer). 

Create a Cover for Your eBook
The options that you have available for creating a cover for your ebook are as 
follows:

1. Use the KDP Cover Creator app on the KDP eBook Contents page to design your 
cover when you upload your ebook. This method is the easiest way to do it. 

2. Use an app like Adobe Photoshop or GIMP(free) to create your ebook cover.

3. Use a simpler online graphics app like Canva to create your cover.

4. Pay a professional graphic designer to design your cover. 

Saving Your Master Project File and Upload File
There are two key files/directories that you should save if you want to save your 
ebook  in  Kindle  Create.  If  you  click  on  the  Save icon(on  the  RHS  of  the  top 
toolbar) you will be asked to save the project folder that contains the KCB project 
file – which is the file that you have created in Kindle Create. If you click on the 
Publish button, this will save your ebook in Kindle Create as a KPF file which you 
can directly upload to KDP. You can also use  Save Project,  Save Project As and 
Publish menu items from the File menu to achieve the same thing if you wish.

The project folder, containing the KCB project file will have a filename containing 
the  title  of  your  ebook  e.g.  your_book_title_KC.kcb. And  the  KPF  file  will  be 
named directly with your actual  ebook  title  e.g.  your_book_title.kpf.  You can 
also rename your file when you save it if you wish.

After  you've  finished  formatting  your  book  in  Kindle  Create  you  should  also 



make sure that you save your Word doc to a safe location. You could just save 
your master Word doc and master KCB project file to your computer's hard drive 
but a much better option would be to save your work to DropBox, Google Drive or 
to  an  external  hard  drive  just  in  case  your  computer  suddenly  crashes  and 
becomes unusable for whatever reason – and you lose all your data. 

Kindle Create Formatting Tips
1.  Don't  touch or reformat your body text in Kindle Create.  You should have 
already formatted the body text properly in MS Word before loading your Word 
doc into Kindle Create.  In Word,  if you have created a novel, you should have 
formatted the body text in the front/back matter as blocktext and formatted the 
chapter text or story text in your novel using fiction style.

2.  Always add your ebook images using Kindle Create because it is the quickest,  
easiest and safest way to do insert images – much easier and more reliable than 
adding your ebook images in MS Word which can be error prone. 

3.  If you've written a novel that you want to publish both as a reflowable ebook  
and  a  paperback  book,  always  make  sure  that  you  style  and  complete  your 
reflowable ebook first in Kindle Create. Then you can simply load your ebook's 
already formatted KCB project file into Kindle Create as the start point for your 
paperback  version  and  just  finish  it  off  and  save  it  as  the  KPF  file  as  your 
paperback version for upload to KDP Print. Doing it this way avoids formatting 
duplication and will save you a whole heap of time. And, in terms of styling and 
layout, your ebook and book versions will look the same.

4.   Also  remember  that  formatting  and  styling  for  a  reflowable  ebook,  fixed 
format ebook or paperback book is the same in MS Word or LibreOffice Writer 
because all these routes initially will require proper Word doc preparation before 
loading into Kindle Create. 

Important Note: Please also note that all  the formatting and styling advice in 
this  chapter  also  applies  when  you  format  a  paperback  book  in  Kindle  create 



because reflowable ebook and print book creation will always use the same route. 
For both reflowable format and paperback format you will have to format a Word 
doc in the same way then load that Word doc loaded into Kindle Create. So the 
Word  doc  preparation  process  is  virtually  the  same  in  both  MS  Word  or 
LibreOffice Writer and finishing-off your ebook or paperback book will also be 
virtually  the  same  for  both  reflowable  ebooks  and  paperback  books  in  Kindle 
Create.

Current Bugs
There is a current bug in Kindle Create which causes the centered main headings 
in the  Look Inside ebook version to be off-centered. To resolve this problem in 
Kindle Create, you should check all the centered chapter headings in your ebook 
in KC to ensure that there are no margin left and margin right values declared. If 
present,  these  margin  left/right  values  should  be  deleted  and  reset  to  "0.00" 
using  Text  Properties  >  Formatting  >  Indents(top  row). This  will  fix  the 
problem. See diagram below.

For centered headings, margin-left and margin-right values are irrelevant and 
should always be set to  "0.00" because the presence of actual values may cause 
wonky  or  off-centered  heading  problems  in  your  LITB  version  when  you 
eventually upload your KPF file to Amazon Kindle. It's also very important that 
you do this check for all headings because this off-centering problem does not 
show up on test using either KC Preview or Kindle Previewer. But this problem 
will show in the Look Inside version of your ebook. So please make sure that you 
do this check to avoid any centering problems in the LITB after you publish your 
ebook. 

There  is  also  another  quirk  or  bug  in  Kindle  Create(loaded  with  a  Word  doc) 
whereby  unwanted  vertical  spacing(blank  lines)  can  be  introduced  by  Kindle 
Create when you format either a reflowable ebook or paperback book. If this is the 



case, all you have to do to get rid of this problem is:

1. Left-click and release as you swipe the unwanted space area with your cursor 
until you cannotsee the cursor.

2. Then just hit the Backspace key on your keyboard and the unwanted vertical 
space(blank lines) should magically disappear.



CHAPTER 5

Create a Fixed Format eBook

For  fixed  format,  you  should  prepare  your  Word  doc  exactly  as  described  in 
either  Chapter  2(using  MS  Word) or  Chapter  3(using LibreOffice  Writer).  You 
should style and layout your book in your Word doc to your own preference.   

Font Size Warning
Take  note  that  after  you  have  created  your  Word  doc  using  MS  Word  or 
LibreOffice Writer, if you just prepared your Word doc in the normal way and 
convert it to PDF and then convert to KPF using Kindle Create, then when you test 
your KPF file in Kindle Previewer all your ebook headings and text will probably 
look way too small and may be unreadable. The reason for this is that your Word 
doc page size is  set by default  to  8.5" x 11" in both MS Word and LibreOffice 
Writer but your fixed format book will be read on Kindle ereading devices with 
screens that are approximately  6" x 4". So, on upload and conversion to Kindle 
format, each ebook page will be converted to a jpeg image for display on all Kindle 
devices and your ebook pages/images will be shrunk to nearly half their original 
size  to  fit  on  smaller-screened  Kindle  devices  like  tablets.  Likewise  the 
text(within the images) in your ebook will also shrink to approximately half their 
original font size. 



There are two ways to properly resize the text/headings  in your fixed format 
ebook:

1.  Adjusting text and heading size using the default page size of 8.5" x 11". 
To make all the fonts in your fixed format ebook a reasonable size for reading on 
Tablets  and  computers  you  should  adjust  your  headings/text  size  by 
approximately doubling the regular or normal font size that you would normally 
use in both MS Word and LibreOffice Writer, in the following way:

1. Check and ensure that the page size of your document is 8.5" x 11" in MS Word 
or LibreOffice Writer.

2. Set the font size to 20pt for all body text or reading text in MS Word or LW.

3. For your chapter headings use a 36pt fontsize.

4. For your book title use 48pt.

5. For  the  ebook  subtitle,  author  name,  chapter  subtitle  etc,  just  double  the 
normal font size that you would normally use then test and adjust to your 
own font size preferences.

6. Set all margins to 0.8".

2. Adjusting the page size to 6" x 9"
Using this method, all you have to do is style your doc in the normal way in MS 
Word or LibreOffice Writer and then do the following:

1. In Word or LW, set the page size of your document to 6" x 9".



2. Set all the page margins to 0.3"(or to your own margin preference).

3. Adjust all the normal body text or reading text to 15pt in Word or LW.

4. Adjust headings and subtitles to your own font size preference.

5. Then test and check your Word doc using  Kindle Previewer.  Check the font 
size and readability.

6. Save to PDF and carefully check your PDF file and ensure that all the chapter 
text and heading text are suitably proportioned and easily readable. 

7. Load the PDF file into Kindle Create.

8. Then  test  again  using  KC  Preview and  also test  your  saved  KPF file  using 
Kindle Previewer. Make absolutely sure that all the body text or reading text 
is easily readable. Remember that Kindle device users will not be able to adjust 
font-size and zoom also does not work well for fixed format ebooks, that's why 
it's so crucial that your ebook's reading text should be easily readable on any 
Kindle device without any necessary adjustments.

Using either of the above methods, your text and headings should look normal 
size and be acceptable on Kindle Tablets and other devices when you eventually 
test and upload your fixed format ebook. Also remember that the Kindle device 
user  will  not  be  able  to  adjust  the  font  size  while  reading  your  fixed  format 
ebook(because each fixed format ebook page is an image – not html text), which is 
why it's especially important to get your ebook heading fonts and body text font 
properly sized and readable during testing before you publish.

Saving Your Word doc as a PDF file
Exporting a PDF File from MS Word
After you've checked and finished your ebook in MS Word, click on Save AsPDF 
then, in the  Save as dialogue window, click on the  "Options" button and make 
sure that  "PDF/A" is ticked for highest quality. Then press "OK"and save your 
Word doc as a PDF file. If you don't do this then all the text, images or diagrams in 
your fixed format Kindle ebook might end up looking blurry and low quality.

Exporting a PDF File from LibreOffice Writer
After you've finished and checked your ebook in LibreOffice Writer, click  File > 
Export As > Export as PDF. In the  PDF Options dialogue, ensure that  "Lossless 
compression"and  "Archive  PDF/A-1a(ISO  19005-1)" are  both  selected(ticked). 
Then  press  "OK" and  save  the  PDF  file  to  your  desktop  or  to  your  preferred 
location.



After  you  have  created  your  PDF  file,  you  should  check  it  carefully  for  any 
formatting or layout errors using an app like Adobe Acrobat Reader(free).

Detailed Workflow
What follows is a description of how you should create your fixed format ebook 
in Kindle Create loaded with a PDF file:

1.  Open the Kindle Create app and,  for the book type, choose the  Textbooks, 
Travel Guides, Cookbooks etc button at the bottom and select and load your PDF 
file into KC.

2.  From the main menu the KC app, click on Edit > Preserve Links to ensure that 
all your internal and external links are enabled and work in your fixed format 
ebook.

3.  You can also update or remove TOC chapter sections in your Interactive TOC 
by clicking on a chapter section in the  Contents panel  and then, in the  Section 
Properties panel, just tick "Include in Table of Contents" and name the heading 
section  and  that  chapter  or  section  will  automatically  be  added  to  your 
Interactive  TOC.  To  remove  a  section  from  the  TOC  just  deselect  or  untick 
"Include in Table of Contents".  And if you want to include the book title page in 
your TOC just use the same method as described and name the page "Title Page". 

See diagram below:

4.  You can add or remove pages in KC by right clicking on a page in the Contents 
panel and selecting  "Insert Page"(as a PDF file) or "Delete Selected Page". 

5.  You can also use Edit > Insert > Movie from File or Audio from File or Image 
from File to add media files to your KC doc. You should also be aware that adding 



and storing media files in your fixed format ebook will substantially increase the 
overall file size of your ebook, which might also incur Kindle's download penalty 
on your ebook profits. 

7.  You should also be aware that, at the moment, fixed format ebooks created 
using Kindle  Create,  all  internal  links and internet links  will  not  work across 
most  Kindle  devices.  This  is  a  known  bug  in  Kindle  Create  which  Kindle 
developers are currently trying to resolve.

Saving Your Work
After  you've  finished  formatting  your  fixed  format  ebook  in  MS  Word  or 
LibreOffice Writer you should always make sure to save your Word doc to a safe 
location. Saving your master PDF file or your KCB project file for a fixed format 
ebook will not allow you to update or fix problems in your fixed format ebook 
after publication,  which is why you must always save your master Word doc. 
You could just save your Word doc to your computer's hard drive but a much 
better  option  would  be  to  save  your  work  to  DropBox,  Google  Drive  or  to  an 
external hard drive just in case your computer suddenly crashes and becomes 
unusable for whatever reason – and you lose all your data. 

How to Reduce Total File Size
When you create a fixed format ebook in Kindle Create,  every single imported 
PDF page will be converted into a full page jpeg image, which will greatly increase 
the file size of your ebook. The total file size of the page images in your ebook is 
important because Amazon Kindle currently charges a profit penalty of $0.15 per 
Mb over their standard limit of 5 Mb for all the ebook images in your ebook. So if 
you have a 150 page book with 150 full page images(derived from each PDF page) 
then you will probably get zero profit if you choose KDP's 70% profit option n 
KDP upload. The only way for you to make a small profit would be to take the 
35% profit KDP option, which will give you a small profit at least.



To help protect your 70% profit option and reduce the total profit penalty of your 
image-dense  fixed  format  ebook,  you  should  always  use  a  good  image  file 
compression application to reduce the size of all your images and all your ebook 
images  must  also  have  an  image  resolution  of  300  ppi  for  best  or  optimum 
quality. One of the best image file compression apps that I've used is a free online 
compression app called  TinyPNG.  This online app is capable of reducing your 
total  image file size by up to 50% with  very little  loss in image  quality(using 
lossless compression). You can even upload all your ebook's images at once in a 
single batch run. Using the TinyPNG app, you should always reduce the file size 
of  all  your  ebook  images  before  you  add  them  to  your  manuscript  in  Kindle 
Create. 

Understanding the Look Inside Version of Your eBook
When you upload your fixed format ebook, on your Amazon product page there 
will be a link to the Look Inside version of your ebook. The Look Inside version 
of your fixed format ebook is an html file which consists of image snapshots of 
every PDF page in your fixed format book. This is often referred to as a "print 
replica" version of your ebook.  

Create a Cover for Your eBook
The options that you have available for creating a cover for your ebook are as 
follows:

1. When you upload your fixed format ebook to KDP, use the KDP Cover Creator app 
on the KDP eBook Content page to design and implement your cover. This is the 
easiest way to create your ebook cover.

2. Use an app like Adobe Photoshop or GIMP(free) to create your book cover.

3. Use a simpler online graphics app like Canva to create your cover.

4. Pay a professional graphic designer to design your cover. 



CHAPTER 6

Create a Paperback Book

This chapter will describe how the user can convert a Word doc to a paperback 
book  using Kindle  Create.  The  Word  doc  preparation  for  a  paperback  book  is 
almost exactly  the same as the preparation  for creating a reflowable ebook  in 
Kindle Create, but with the following differences in the paperback version:

1. You will have a doc TOC without links and each TOC item will contain a reference  
page number.

2. Consecutive page numbering will be added from the start point that you set in 
Kindle Create (usually starting at chapter one).

3. Alternating  title/author  name  headers  will  automatically  be  added  to  your 
chapter pages.

If you use Kindle Create to create your paperback book, then you will get a KPF 
file for direct upload to KDP Paperback. During KDP conversion process, the KPF 
file will be converted to a PDF file, which will then be used as the final blueprint to 
print your paperback.

The trim sizes for creating a paperback using KC will be the same trim sizes used 
for uploading a Word doc or PDF to KDP Print. See this link for KDP print options:

https://kdp.amazon.com/en_US/help/topic/G201834180


Detailed Workflow
There are two ways to create a paperback book using Kindle Create:

1. Creating just a paperback book
You should format your book in Kindle Create in exactly the same way as you 
would format a reflowable ebook in KC. So you should first format it accordingly 
as described in Chapter 2(using MS Word) or Chapter 3(using LibreOffice Writer). 
You  can  now  also  style  the  layout  of  the  title/author  headers  and  the  page 
number footers to your own preference by selecting the Print Settings icon in the 
toolbar. Finally, you should add a non-clickable doc TOC to your book by right-
clicking  on  a  section  in  the  Contents panel  and  choose  "Insert  Table  of 
Contents".  The  new  doc  TOC  page  will  be  automatically  added  above  your 
selected section. The TOC items in the new doc TOC will not have associated page 
numbers added until after you upload to KDP Print.

2. Creating an ebook and a paperback book of your novel.
If  you  are  preparing  your  novel  using  KC  in  both  reflowable  format  and 
paperback format then you should always prepare your ebook first because then 
you can load your ebook's already-formatted KCB project file into Kindle Create to 
finish off your paperback book. If you do it this way in KC you will you will only 
select a layout style for your headers and footers(as described above) and finally 
just add a doc TOC to your paperback version using Kindle Create. Doing it this 
way  avoids  unnecessary  formatting  duplication,  which  will  save  you  a  huge 
amount of time.



The end result of formatting your book as above is that the paperback version of 
your novel, in terms of styling and layout, should look exactly the same as your 
ebook version.

3. Automated tasks on upload to KDP Print
The following tasks will automatically be completed when you upload your KPF 
file as a paperback to KDP Print:

1. Consecutive  page  numbering  will  automatically  be  detected  and  added 
correctly to all pages starting at your from chapter 1 in your book.

2. The  alternating  title/author  headers  will  automatically  be  set  correctly 
throughout your book from chapter 1.

3. The TOC item page numbers will automatically be calculated and added to all  
the  TOC  items  on  your  KC-generated  TOC  page  when  you  upload  to  KDP 
Paperback.

4. All  calculations  for  trim,  bleed,  spine,  paper  type,  margins  etc  will 
automatically be set or calculated from the metadata on the KDP Paperback 
Details and Contents pages when you upload your book to KDP Paperback.

Understanding the Look Inside Version of Your Book
After you upload your print book, on your Amazon product page there will be a 
link to the Look Inside version of your paperback book. The Look Inside version 
of your paperback book is effectively an image snapshot of every page of your 
print book. This is often referred to as a "print replica" version of your paperback 
book because the digital version looks exactly like your print book in all respects.



Create Your Wraparound Book Cover
The options that you have for creating your own paperback book cover are as 
follows:

1. Create  your  wraparound  cover  using  Cover  Creator on  the  KDP  Paperback 
Content page when you upload your book. This is the easiest way to create and 
implement your wraparound book cover.

2. You  can  also  use  graphic  apps  like  Adobe  InDesign,  Adobe  Photoshop, 
InkScape(free),  Scribus(free),  or  GIMP(free)  to  create  your  wraparound  book 
cover.

3. Hire a professional graphic designer to create a wraparound cover for your book.

Current Bugs
Ensure that indent settings for all  centered headings are set to  "0.00"at  Text-
Properties > Formatting tab > Indents. If there are any values set, these values 
could cause wonky or off-centered headings in your book. 

There  is  a  quirk  or  bug  in  Kindle  Create  whereby  unwanted  vertical 
spacing(blank lines) can be introduced by Kindle Create when you format Word 
doc either as a reflowable ebook or a paperback book. If this is the case, all you 
have to do to get rid of this problem is:

1. Left-click and swipe and release in the unwanted space area with your cursor 
until you cannot see the cursor.

2. Then just click the Backspace key on your keyboard and the all the unwanted 
vertical space(blank lines) should magically disappear.



CHAPTER 7

Testing Your KPF file

You  can  only  test  your  KC-generated  KPF  file  for  ebooks  using  either  Kindle 
Create Preview or by using Kindle Previewer(free app download from Amazon). 
I  much prefer using the  Kindle Previewer standalone app because it tells you 
much more information about your KPF file. Also remember that you will not be 
able to test your ebooks by side-loading them onto a Kindle device.

Be sure  to  save your Word  doc  and KCB  project  file  to a  safe  and memorable 
location. You should always save the master files of your ebook or book to a safe 
location such as DropBox, Google Drive or to an external hard drive just in case 
you have a calamity on your computer and you lose all your data. 

Testing Your Reflowable eBook
Perform the following checks on your reflowable KPF file using Kindle Previewer 
in the following way: 

1. Visually check your ebook's text,  headings and layout in  Tablet, Phone and 
Kindle e-Reader mode to ensure all displays are acceptable.

2. Check that all internal and external links work by clicking on them.

3. Check that your Interactive TOC is there on the device emulation and that all 
links are working.

4. Click the Navigation menu and check that the Table of Contents link is there 
in the list and not grayed out. Check that the link works. All links, apart from 
the link to the Cover, should be working.

5. Click on View > Book Information and ensure that all the ebook metadata and 
specified data is there.  It is normal for the Cover link to be  "Not Specified" 
because this link should be added after you upload your ebook and Amazon 
Product Page cover to Amazon. 

6. Lastly,  when you upload to  KDP, you should also do a final check on your 
reflowable ebook by using Kindle eBook Preview on the KDP eBook Contents 
page(in your  KDP Bookshelf) to check your ebook. You can also check your 
paperback book as described without having to publish your book. So you can 



use this facility for testing and checking your paperback book any time you 
like.

Testing Your Fixed Format eBook
This section describes how to check your fixed format KPF file using the Kindle 
Previewer app.

1. Visually check your ebook's reading text, headings, spacing and layout.

2. Check that the headings and text are easily readable on tablet devices.

3. Check that the internal and external links in your doc TOC all work.

4. Check that your Interactive TOC is there and that all links are working.

5. Click on  View > Book  Information and  ensure that all  the required  ebook 
metadata  and  specified  links  are  there.  Also  note  that,  in  the  Navigation 
menu,  both  Beginning and  Table  of  Contents will  be  grayed  out.  This  is 
normal  for  Kindle  fixed  format  ebooks.  Similarly,  in  View  >  Book 
Information, both  Table of Contents and  Start Reading will be unspecified. 
This is also normal for Kindle fixed format ebooks. 

6. Lastly, when you upload your fixed format ebook to KDP, you should also do a 
final check on your reflowable ebook by using  Kindle eBook Preview on the 
KDP eBook Contents page(in your  KDP Bookshelf). You can also check your 
paperback book as described without having to publish your book. So you can 
use this check facility for testing and checking your paperback book any time 
you like.



Testing Your Paperback Book 
There is only one way to test your KC-generated KPF file for paperback. You can 
only  test  it  when  you  upload  your  KPF  file  to  KDP  Paperback.  Complete  the 
details in the KDP Book Details page(in your KDP Bookshelf) and then go to the 
KDP  Paperback  Content page  and  complete  the  details  then  upload  your 
manuscript  and  wraparound  book  cover  or  use  Cover  Creator.  Then  click  the 
preview button in  KDP Book Preview on the  KDP Paperback Content page(in 
your KDP Bookshelf) to see your whole book, including book cover. You should 
check  and  inspect  your  book  thoroughly  and  carefully  before  you  actually 
publish. You can also check your paperback book as described without having to 
publish your book.  So you can use this check facility for testing and checking 
your paperback book any time you like.



CHAPTER 8

Kindle Create Best Practice Advice

This chapter is just a quick best practice run-through for ebooks and paperback 
books created using Kindle Create and is meant to be just a helpful reminder for 
the reader. Try and avoid all the pitfalls listed below.

Dos and Don'ts
1.  For reflowable ebooks and paperback books, always insert your ebook/book 
images using Kindle Create – not MS Word. I've hammered this point throughout 
this book for good reasons. Adding your images in Kindle Create is much quicker, 
easier and less error prone than adding them in Word and you will also get better 
quality images as a result. You will also notice the difference.

2.   You should always do most, if not all, of your ebook formatting, layout and 
styling in MS Word or LibreOffice Writer using paragraph styles before you load 
your Word doc into Kindle Create to finish off the interior styling. If you ignore 
this advice then it will take you much longer to format your ebook/book because 
you will have to format all your headings, text and spacing in Kindle Create on a 
one-by-one basis using inline styling. Kindle Create does not give you the ability 
to create or use named paragraph styles like MS Word or LW. Also bear in mind 
that  Kindle  Create  should  never  be  used  to  create  an  ebook/book  from  an 
unformatted Word doc. Remember that Kindle Create is just a finishing-off tool 
whose main purpose is to make it easier to spruce up the interior styling of your 
book. 

3.  It doesn't matter whether you create a reflowable ebook, a fixed format ebook 
or a paperback book, your start point will always be a Word doc when you use 
Kindle  Create.  So it's  essential  that  you  should  already  be  up  to  speed  on  the 
Kindle formatting guidelines for Word and you should also know how to use and 
apply paragraph styles in MS Word or LibreOffice Writer. 

4.  In KC, the quickest way to produce both a reflowable ebook and a paperback 
book of your novel is to first create and complete the KCB project file for your 
ebook. Then you can load that already-formatted KCB file into Kindle Create and 
use that as the start point to create your paperback book. Doing it this way avoids 



formatting duplication and will save you a ton of time and effort. 

5.  For reflowable ebooks only, it's OK and quite permissible in KC to insert images 
at resolutions of  between 72 ppi and 150 ppi in your ebook. This helps the indie 
publisher to economize on their upload file size, thus also helping to avoid the 
Kindle deliverable file size penalty on their ebook profits.

6.   If  you  are  creating  images  for  fixed  format  ebooks  or  paperback  books 
generated using Kindle Create, you must always insert images at 300 ppi for best 
quality.  In  both  fixed format  books  and  paperback  books  formatted  in  Kindle 
Create, these formats will eventually be converted to PDF and when your images 
are  converted  to  PDF  images  –  at  PDF/A  quality  –  that  means  that  the  image 
resolution for all your images will automatically be upsized to 300 ppi. So if your 
images are 72 ppi or 96 ppi to start with then the resulting upsized images in the 
PDF  will  most  likely  be  blurry  and  poor  quality  due  to  image 
extrapolation(expansion) causing excessive image pixelation. So, for fixed format 
books and paperback books created using KC, all your images must always have 
an original photo-capture resolution of 300 ppi for best image quality results. 

7.  When you use KC, remember that the styling and formatting requirements for 
a  reflowable  ebook  in  Word  or  LibreOffice  Writer(LW)  are  almost  exactly  the 
same  as  the  styling and formatting requirements  for  a  paperback  book  in  MS 
Word  or  LW.  Similarly,  the  styling  requirements  and  workpath  for  your 
reflowable ebook and paperback book in Kindle Create will be virtually the same 
because both these formatting routes use a Word doc loaded into Kindle Create.  

8.  After you have completed your reflowable ebook or paperback book in Kindle 
Create you should always save your master Word doc and master KCB project file 
to a safe location like DropBox, Google Drive or external hard drive in case you 
have a computer disaster and lose all your data. For fixed format ebooks you must 
always ensure that you always save your master Word doc to a safe location.

9.  As a habit, you should always save your master Word doc and master KCB 
project file to a safe location after publishing your book/ebook. I don't know how 
many  times  I've  read  posts  from  desperate  indie  publishers  on  the  KDP 
Community forum, who forgot or just didn't bother to save their master Word 
doc or master KCB file after publication and were begging to know how to recover 
their original master Word doc or master KCB file. Without saving your Word doc 
or KCB project file you will not be able to fix problems or update your ebook/book 
after publication.

10. Bear in mind that if you create a paperback book using Kindle Create then you 
will  only be able to check and test  it  using  Kindle Book Preview on the  KDP 



Paperback Content page on your KDPBookshelf when you upload your book to 
Amazon Kindle.  

11. If you have a lot of images in your reflowable ebook or you are creating a fixed 
format  ebook,  you  should  always  compress  your  images  using  the  TinyPNG 
website before you insert them into your ebook using Kindle Create. Doing this 
will  help  considerably  to  reduce  your  total  ebook  file  size.  I  use  TinyPNG to 
compress all  my images in my reflowable ebooks regardless of whether it's an 
image-dense ebook or not because this is a good habit that will always reward 
you with a smaller upload file. 

12. You should always try and avoid creating fixed format ebooks using Kindle 
Create because  of  all  its  many downsides.  If  you can,  always  try and create  a 
reflowable  ebook,  which  has  many  more  advantages  than  the  somewhat 
troublesome fixed format ebook.

13.   If  you  are  creating  or  processing  images  for  your  ebook/book  then  you 
should  always  use  good  graphics  apps  like  Adobe  Photoshop,  GIMP(free)  or 
Irfanview(free) for these tasks. 
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